Software Revision

The latest firmware is available at:

- www.keysight.com/find/DAQ970Afirmware
- www.keysight.com/find/DAQ973Afirmware

The latest product documentation is available at:

- www.keysight.com/find/DAQ970Amanuals
- www.keysight.com/find/DAQ973Amanuals

A portion of the software in this product is licensed under terms of the General Public License Version 2 (GPLv2). The text of the license and source code can be found at www.keysight.com/find/GPLV2.

This product uses Microsoft Windows CE. Keysight highly recommends that all Windows-based computers connected to Windows CE instruments use current anti-virus software. For more information, go to the respective product page at:

- www.keysight.com/find/DAQ970A
- www.keysight.com/find/DAQ973A
Safety Considerations

Read the information below before using this instrument.

The following general safety precautions must be observed during all phases of operation, service, and repair of this instrument. Failure to comply with these precautions or with specific warnings elsewhere in this manual violates safety standards for design, manufacture, and intended use of the instrument. Keysight Technologies assumes no liability for the customer’s failure to comply with these requirements.

**WARNING**

BEFORE APPLYING POWER

Verify that all safety precautions are taken. Make all connections to the unit before applying power.

**WARNING**

GROUND THE INSTRUMENT

This product is provided with protective earth terminals. To minimize shock hazard, the instrument must be connected to the ac power mains through a grounded power cable, with the ground wire family connected to an electrical ground (safety ground) at the protective (grounding) conductor. Disconnection of the protective earth terminal will cause a potential shock hazard that could result in personal injury.

**WARNING**

BEFORE POWER ON AND OFF

Before powering on the instrument, make sure all signal sources connected to modules are turned off. Turn on signal sources after the instrument is powered on. Turn off signal sources before the instrument is powered off.

**WARNING**

DO NOT REMOVE THE INSTRUMENT COVER

Only qualified, service-trained personnel who are aware of the hazards involved should remove the instrument covers. Always disconnect the power cable and any external circuits before removing the instrument cover.
WARNING
MODULE COVERS
Always reinstall module covers after terminal wiring and before inserting into mainframe.

WARNING
DO NOT OPERATE IN AN EXPLOSIVE ATMOSPHERE
Do not operate the instrument in the presence of flammable gases or fumes.

WARNING
DO NOT MODIFY THE INSTRUMENT
Do not install substitute parts or perform any unauthorized modification to the product. Return the product to a Keysight Sales and Service Office for service and repair to ensure that safety features are maintained.

WARNING
DO NOT MEASURE MORE THAN THE RATED VOLTAGE
Maximum voltage as marked on each module is as below:
- DAQM900A: 120 Vrms
- DAQM901A, DAQM902A, DAQM903A, DAQM904A, DAQM908A: 300 Vrms
- DAQM905A, DAQM907A: 42 Vpk
- DAQM909A: +/-18Vpk (single ended) for both HI and LO pins.

WARNING
DO NOT CONNECT ANY MODULE CHANNELS TO MAINS
Measurement category of the instrument is rated as CAT 'Others', terminals should not be directly connected to the mains.
WARNING

AC POWER CORD

Removal of the AC power cord is the disconnect method to remove power from the instrument. Be sure to allow for adequate access to the power cord to permit disconnection from AC power. Use only the Keysight specified power cord for the country of use or one with equivalent ratings.

WARNING

SELF-TEST

Before measuring any hazardous voltage or current, run the *TST? query from the remote interface, and read the result to verify that the instrument is performing properly. The *TST? query is a self-test that returns +0 if the instrument passes and +1 if the instrument fails. You can also perform this query from the front panel by pressing [Utility] > Self Test > Quick Test. If this self-test fails, make sure that the instrument is repaired and passes the self-test before continuing.

WARNING

IN CASE OF DAMAGE

Instruments that appear damaged or defective should be made inoperative and secured against unintended operation until they can be repaired by qualified service personnel.

CAUTION

MEASUREMENT CONSIDERATIONS

This is a sensitive measurement apparatus by design and may have some performance loss when exposed to ambient continuous electromagnetic phenomenon. Consider using shielded or twisted cables, common mode chokes, ferrite clamps, and damping resistors before the input to the DAQ970A/DAQ973A.
CAUTION

CLEANING

To prevent electrical shock, disconnect the instrument from AC mains power before cleaning. Clean the outside of the instrument using a soft, lint-free, cloth slightly dampened with water. Do not use detergent or solvents. Do not attempt to clean internally. If needed, contact a Keysight Technologies Sales and Service Office to arrange for proper cleaning to ensure that safety features and performance are maintained.
Environmental Conditions

The DAQ970A/DAQ973A is designed for indoor use and in an area with low condensation. The table below shows the general environmental requirements for this instrument.

<table>
<thead>
<tr>
<th>Environmental condition</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Temperature</strong></td>
<td></td>
</tr>
<tr>
<td>Operating condition</td>
<td>0 °C to 55 °C</td>
</tr>
<tr>
<td>Storage condition</td>
<td>−40 °C to 70 °C</td>
</tr>
<tr>
<td><strong>Humidity</strong></td>
<td></td>
</tr>
<tr>
<td>Operating condition</td>
<td>Up to 80% RH at 40°C (non-condensing), decreasing linearly to 50% RH at 55 °C (non-condensing)</td>
</tr>
<tr>
<td>Storage condition</td>
<td>Up to 50% RH at 55°C (non-condensing)</td>
</tr>
<tr>
<td><strong>Altitude</strong></td>
<td></td>
</tr>
<tr>
<td>Operating condition</td>
<td>Up to 3,000 m (9,840 ft.)</td>
</tr>
<tr>
<td><strong>Pollution degree</strong></td>
<td>2</td>
</tr>
</tbody>
</table>
Regulatory Information

This instrument is designed to comply with the following safety and EMC requirements:

**Safety compliance:**
- Canada: CAN/CSA-C22.2 No.61010-1-12; CAN/CSA-C22.2 No.61010-2-030-12

**EMC compliance:**
- IEC 61326-1:2012 / EN 61326-1:2013
- Canada: ICES/NMB-001:2006
- Australia/New Zealand: AS/NZS CISPR 11:2011
- South Korea RRA Notice 2016-24
## Safety Symbols and Regulatory Markings

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Alternating current (AC)" /></td>
<td>Alternating current (AC)</td>
</tr>
<tr>
<td><img src="image" alt="Protective earth (ground) terminal" /></td>
<td>Protective earth (ground) terminal</td>
</tr>
<tr>
<td><img src="image" alt="Earth (ground) terminal" /></td>
<td>Earth (ground) terminal</td>
</tr>
<tr>
<td><img src="image" alt="Caution, risk of danger (refer to this manual for specific Warning or Caution information)" /></td>
<td>Caution, risk of danger (refer to this manual for specific Warning or Caution information)</td>
</tr>
<tr>
<td><img src="image" alt="Frame or chassis (ground) terminal" /></td>
<td>Frame or chassis (ground) terminal</td>
</tr>
<tr>
<td><img src="image" alt="Instrument cable lock." /></td>
<td>Instrument cable lock.</td>
</tr>
<tr>
<td><img src="image" alt="This product is marked with the ACMA RCM mark for compliance in Australia/New Zealand. A copy of the Manufacturer's Australia Declaration of Conformity for this instrument can be obtained by contacting your local Keysight Technologies Sales Representative." /></td>
<td>This product is marked with the ACMA RCM mark for compliance in Australia/New Zealand. A copy of the Manufacturer's Australia Declaration of Conformity for this instrument can be obtained by contacting your local Keysight Technologies Sales Representative.</td>
</tr>
<tr>
<td><img src="image" alt="This symbol indicates the time period during which no hazardous or toxic substance elements are expected to leak or deteriorate during normal use. Forty years is the expected useful life of the product." /></td>
<td>This symbol indicates the time period during which no hazardous or toxic substance elements are expected to leak or deteriorate during normal use. Forty years is the expected useful life of the product.</td>
</tr>
</tbody>
</table>
South Korean Class A EMC Declaration

Information to the user:

This instrument has been conformity assessed for used in business environments. In a residential environment this equipment may caused radio interference.

This EMC statement applies to the equipment only for use in business environment.

사용자 안내문

이 기기는 업무용 환경에서 사용할 목적으로 적합성평가를 받은 기기로서 가정용 환경에서 사용하는 경우 전파간섭의 우려가 있습니다.

사용자 안내문은 "업무용 방송통신기자재"예에만 적용한다.
Waste Electrical and Electronic Equipment (WEEE) Directive

This instrument complies with the WEEE Directive marking requirement. This affixed product label indicates that you must not discard this electrical or electronic product in domestic household waste.

Product category:

With reference to the equipment types in the WEEE directive Annex 1, this instrument is classified as a “Monitoring and Control Instrument” product. The affixed product label is as shown below.

Do not dispose in domestic household waste.

To return this unwanted instrument, contact your nearest Keysight Service Center, or visit http://about.keysight.com/en/companyinfo/environment/takeback.shtml for more information.

Sales and Technical Support

To contact Keysight for sales and technical support, refer to the support links on the following Keysight websites:

- www.keysight.com/find/DAQ970A or www.keysight.com/find/DAQ973A (product-specific information and support, software and documentation updates)
- www.keysight.com/find/assist (worldwide contact information for repair and service)
Table of Contents

Software Revision ................................................................. 3
Safety Considerations ............................................................. 4
Environmental Conditions ....................................................... 8
Regulatory Information .......................................................... 9
Safety Symbols and Regulatory Markings ................................. 10
South Korean Class A EMC Declaration ................................. 11
Waste Electrical and Electronic Equipment (WEEE) Directive .......... 12
  Product category: .............................................................. 12
Sales and Technical Support .................................................... 12

1 Service and Repair
General Information ............................................................. 18
  Types of service available .................................................... 18
  Keysight unit exchange ....................................................... 18
  Repackaging for shipment ................................................... 19
  Cleaning ................................................................... 19
  Electrostatic discharge (ESD) precautions ......................... 19
  User replaceable parts ....................................................... 20
  Specifications and characteristics ......................................... 20
Troubleshooting ................................................................... 21
  Operating checklist .......................................................... 21
  General troubleshooting hints ............................................. 21
Self-test Procedures ............................................................. 23
  Power-on self-test ............................................................ 23
  Full self-test ................................................................. 24
  Plug-in module self-test .................................................... 24
  Self-test duration ............................................................. 25
Battery Check and Replacement ............................................. 26
  To verify or replace the battery ........................................... 27
Disassembly ................................................................. 28
2 Calibration Procedures

Keysight Technologies Calibration Service ........................................... 34
Calibration Interval ................................................................. 34
  Adjustment is recommended .................................................. 34
Time Required for Calibration ..................................................... 34
Automating Calibration Procedures ............................................... 35
Recommended Test Equipment ..................................................... 36
Input Connections ................................................................. 37
  Short (Zero) ................................................................. 37
  Input test signal ........................................................... 38
Calibration Security ................................................................. 39
  To unsecure for calibration .................................................. 40
  To secure against calibration .............................................. 40
  To change the security code ................................................. 41
  To unsecure the instrument without the security code .......... 42
Calibration Message .............................................................. 44
Calibration Count ................................................................. 44
Recommended Calibration Procedure .......................................... 45
Aborting a Calibration in Progress ............................................. 45
Calibration Actions ............................................................... 46
  Entering calibration values ............................................... 46
  Storing calibration constants .............................................. 46
Test Considerations ............................................................. 47
  Environmental conditions ................................................. 47
  Calibrator setup .......................................................... 48
  Channel delay ............................................................... 49
  Channel monitor ........................................................... 50
Calibration Adjustment Sequence .............................................. 51
### Internal DMM Adjustments

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zero Adjustment</td>
<td>52</td>
</tr>
<tr>
<td>Zero and ADC calibration</td>
<td>52</td>
</tr>
<tr>
<td>AC zero calibration</td>
<td>53</td>
</tr>
<tr>
<td>Capacitance zero calibration</td>
<td>54</td>
</tr>
</tbody>
</table>

### Gain Adjustment

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gain and flatness adjustment considerations</td>
<td>55</td>
</tr>
<tr>
<td>Valid gain adjustment input values</td>
<td>56</td>
</tr>
<tr>
<td>AC voltage low frequency gain and flatness calibration</td>
<td>56</td>
</tr>
<tr>
<td>AC voltage gain and flatness calibration</td>
<td>57</td>
</tr>
<tr>
<td>AC current gain and flatness calibration</td>
<td>58</td>
</tr>
<tr>
<td>Frequency accuracy calibration</td>
<td>59</td>
</tr>
<tr>
<td>DC voltage gain calibration (~10 V)</td>
<td>60</td>
</tr>
<tr>
<td>Ohms gain calibration (2-wire and 4-wire)</td>
<td>61</td>
</tr>
<tr>
<td>DC current gain calibration</td>
<td>62</td>
</tr>
<tr>
<td>DC high voltage gain calibration (~100 V)</td>
<td>63</td>
</tr>
</tbody>
</table>

### Performance Verification

#### 3 Performance Verification

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quick Performance Check</td>
<td>66</td>
</tr>
<tr>
<td>Performance Verification Tests</td>
<td>67</td>
</tr>
<tr>
<td>Internal DMM Verification Tests</td>
<td>68</td>
</tr>
<tr>
<td>Zero Offset Verification</td>
<td>68</td>
</tr>
<tr>
<td>Gain Verification</td>
<td>69</td>
</tr>
<tr>
<td>Plug-in Module Test Considerations</td>
<td>76</td>
</tr>
<tr>
<td>Relay Verification</td>
<td>78</td>
</tr>
<tr>
<td>DAQM900A solid state relay on-resistance verification (optional)</td>
<td>78</td>
</tr>
<tr>
<td>DAQM901A relay contact resistance verification (optional)</td>
<td>79</td>
</tr>
<tr>
<td>DAQM901A shorted relay contact verification</td>
<td>81</td>
</tr>
<tr>
<td>DAQM902A relay contact resistance verification (optional)</td>
<td>82</td>
</tr>
<tr>
<td>DAQM902A shorted relay contact verification</td>
<td>83</td>
</tr>
<tr>
<td>DAQM903A relay contact resistance verification (optional)</td>
<td>83</td>
</tr>
<tr>
<td>DAQM903A shorted relay contact verification</td>
<td>84</td>
</tr>
<tr>
<td>DAQM904A relay contact resistance verification (optional)</td>
<td>85</td>
</tr>
<tr>
<td>DAQM904A shorted relay contact verification</td>
<td>88</td>
</tr>
</tbody>
</table>
DAQM905A relay verification (optional) .................. 89
DAQM908A relay contact resistance verification (optional) .......... 90
DAQM908A shorted relay contact verification .................. 90
DAQM907A Analog Output Verification (Optional) .............. 92
DAQM907A Analog Sense Inputs Verification (Optional) .......... 93
Thermocouple Reference Junction Verification (Optional) ......... 94
DAQM909A DC/AC Coupling Verification (Optional) ............. 95
1 Service and Repair

General Information 18
Troubleshooting 21
Self-test Procedures 23
Battery Check and Replacement 26
Disassembly 28

This chapter discusses the procedures involved for returning a failed instrument to Keysight Technologies for service or repair.
General Information

Types of service available

If your instrument or plug-in module fails during the warranty period, Keysight Technologies will replace the unit free of charge. After your warranty expires, Keysight Technologies will replace the unit at a competitive price. The replacement units are fully refurbished and are shipped with new calibration certificates.

NOTE
Each replacement unit has its own serial number. The serial number of the defective unit does not transfer to the replacement unit. The warranty period of the replacement unit is based on the remaining warranty of the defective instrument or plug-in module.

Keysight unit exchange

You can contact Keysight Technologies for unit exchange, warranty, service, or technical support.

- In the United States: (800) 829-4444
- In Europe: 31 20 547 2111
- In Japan: 0120-421-345

Use www.keysight.com/find/assist to contact Keysight worldwide, or contact your Keysight Technologies representative.

The Keysight Unit Exchange applies to the DAQ970A/DAQ973A mainframe only. Plug-in modules are not supported as exchange assemblies. When exchanging the DAQ970A/DAQ973A, do not ship the plug-in modules with your instrument. Remove all plug-in modules and customer wiring before shipping the unit to Keysight.

NOTE
The defective unit must be returned to Keysight before the replacement unit is shipped to you. Additional information regarding unit exchange will be provided when you contact Keysight.
Repackaging for shipment

If the unit is to be shipped to Keysight Technologies for service or repair, be sure to:

– Attach a tag to the unit identifying the owner and indicating the required service or repair.
– Include the instrument model number and your full serial number.
– Place the unit in its original container with appropriate packaging material.
– Secure the container with strong tape or metal bands.

If the original shipping container is not available, place your unit in a container which will ensure at least 4 inches of compressible packaging material around all sides for the instrument. Use static-free packaging materials to avoid additional damage to your unit.

*Keysight Technologies suggests that you always insure shipments.*

Cleaning

Unplug the instrument before cleaning it. Clean the outside of the instrument and plug-in modules with a soft, lint-free, slightly dampened cloth. Do not use detergent. Disassembly is not required or recommended for cleaning.

Electrostatic discharge (ESD) precautions

Almost all electrical components can be damaged by electrostatic discharge (ESD) during handling. Component damage can occur at electrostatic discharge voltages as low as 50 volts.

The following guidelines will help prevent ESD damage when servicing the instrument or any electronic device.

– Disassemble instruments only in a static-free work area.
– Use a conductive work area to dissipate static charge.
– Use a conductive wrist strap to dissipate static charge accumulation.
– Minimize handling.
– Keep replacement parts in original static-free packaging.
– Remove all plastic, styrofoam, vinyl, paper, and other static-generating materials from the immediate work area.
– Use only anti-static solder suckers.

**WARNING**

SHOCK HAZARD. Only service-trained personnel who are aware of the hazards involved should remove the instrument covers. To avoid electrical shock and personal injury, make sure to disconnect the power cord from the instrument before removing the covers.

User replaceable parts

You can find the instrument support part list at Keysight's Test & Measurement Parts Catalog at [http://www.keysight.com/find/parts](http://www.keysight.com/find/parts).

Specifications and characteristics

Troubleshooting

Operating checklist

Before returning your instrument to Keysight Technologies for service or repair, check the following items:

1. Is the instrument inoperative?
   - Verify that the AC power cord is connected to the instrument.
   - Verify that the front panel [On/Standby] switch has been pushed.

2. Does the instrument fail its self-test?
   - Remove all input connections to the instrument. Errors may be induced by AC signals present on the input wiring during a self-test. Long test leads can act as an antenna causing pick-up of AC signals.

3. Is the Current measurement function inoperative?
   - Verify the input protection fuses on the DAQM901A multiplexer module. If necessary, replace with a 1.6 A, 250 V, fast acting, cartridge body, and 5.2 x 20 mm fuse.
   - Note that the current input is only available on Channels 21 and 22 of the DAQM901A multiplexer module.

General troubleshooting hints

This section provides a brief check list of common failures. Before troubleshooting or repairing the instrument, make sure the failure is in the instrument rather than any external connections. Also make sure that the instrument is accurately calibrated within the last year (see Chapter 2, “Calibration Procedures”). The instrument's circuits allow troubleshooting and repair with basic equipment such as a 6½-digit multimeter.
Unit is inoperative
- Verify that the AC power cord is connected to the instrument.
- Verify that the front panel [On/Standby] switch has been pushed.
- Remove all plug-in modules to verify that a plug-in module is not causing the failure.

Unit fails power-on self-test
Remove all plug-in modules and cycle the instrument’s power again. If the instrument does not show a failure, replace or troubleshoot the plug-in module.

Unit reports error 705
This error may be produced if you accidentally turn off power to the unit during a calibration or while changing a non-volatile state of the instrument. Recalibration or resetting the state should clear the error. If the error persists, a hardware failure may have occurred.

A list of all error codes can be found in the DAQ970A/DAQ973A Programming Guide.

Isolating to an assembly
- Remove all plug-in modules to isolate between the instrument and the plug-in modules.
- Listen for the fan when you press the [On/Standby] switch. Fan operation indicates some operation of the main controller and power supplies.
- Try to operate the instrument from a remote interface. If remote operations are normal, the display should be replaced or repaired.
Self-test Procedures

Power-on self-test

Each time the instrument is powered on, a small set of self-tests are performed. These tests check that the minimum set of logic and measurement hardware are functioning properly. Any plug-in modules installed are verified for two-way communication with the main controller. This self-test is equivalent to the *TST? SCPI query, and you do not need to remove inputs to the instrument to run the test. The power-on self-test takes approximately five seconds.

The following procedures shows you how to manually perform a quick instrument self-test:

Front panel operations

2. Select Quick Test and view the result: “Self-test passed” or “Self-test failed”.

You can read errors from the error queue by pressing [View] > Errors. Refer to DAQ970A/DAQ973A Programming Guide for a complete list of self-test errors.

Remote interface operations

1. Connect to the instrument using the remote USB interface.
2. Send *TST? and read the result: pass (+0) or fail (+1).

Use SYSTem:ERRor? to view the errors in the error queue. Refer to DAQ970A/DAQ973A Programming Guide for a complete list of self-test errors.
Full self-test

A complete self-test (TEST:ALL? command) tests all of the items tested by the power-on self-test and includes further tests for gain, current source, and shunt circuitry.

When the tests are completed, either “Self-test passed” or “Self-test failed” appears on front panel.

Execute the complete self-test before performing any verification or calibration procedures.

The following procedures shows you how to manually perform a full instrument self-test:

Front panel operations

2. Select Full Test and view the result: “Self-test passed” or “Self-test failed”.
   You can view the errors in the error queue by pressing [View] > Errors. Refer to the DAQ970A/DAQ973A Programming Guide for a complete list of self-test errors.

Remote interface operations

1. Connect to the instrument using the remote USB interface.
2. Send TEST:ALL? and read the result: pass (+0) or fail (+1).
   Send SYSTem:ERRor? to read the errors in the error queue. Refer to the DAQ970A/DAQ973A Programming Guide for a complete list of self-test errors.

Plug-in module self-test

No user self-test exists for the plug-in modules. The plug-in modules perform their own self-test when power is applied. Additionally, the mainframe checks two-way communication with all plug-in modules at power on.

Each plug-in module also performs error checking at regular intervals during operation and any errors detected are reported via the status system to the main controller.
Self-test duration

The table below shows a summary of the estimated time taken for a self-test operation with relevant individual modules.

<table>
<thead>
<tr>
<th>Type</th>
<th>Area</th>
<th>Estimated time (s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power-on self-test</td>
<td>Internal DMM</td>
<td>~1.5 seconds</td>
</tr>
<tr>
<td></td>
<td>DAQM907A</td>
<td>~0.1 seconds</td>
</tr>
<tr>
<td></td>
<td>DAQM909A</td>
<td>~3.5 seconds</td>
</tr>
<tr>
<td>Full self-test</td>
<td>Internal DMM</td>
<td>~3 seconds</td>
</tr>
<tr>
<td></td>
<td>DAQM907A</td>
<td>~6 seconds</td>
</tr>
<tr>
<td></td>
<td>DAQM909A</td>
<td>~23 seconds</td>
</tr>
</tbody>
</table>

**Total duration calculation**

Example 1:
Full self-test with 3 units of DAQM907A in one mainframe:

Total duration = Internal DMM + (3 x DAQM907A) = 3 + (3 x 6) = ~21 seconds

Example 2:
Full self-test with 3 units of DAQM909A in one mainframe:

Total duration = Internal DMM + (3 x DAQM909A) = 3 + (3 x 23) = ~72 seconds

**NOTE**
All self-test operations (power-on self-test, or full self-test) will always include the mainframe’s internal DMM.
Battery Check and Replacement

The internal battery, a CR2032 3 V lithium button battery, provides power to the internal real-time clock and reading storage memory whenever the AC line power is removed.

NOTE

The internal battery state does not affect the calibration memory. The battery has an expected life of approximately 4 years. The battery life will be reduced if the instrument is stored for prolonged periods at temperatures above 40 °C with the ac power removed. The battery is not used whenever the AC line power is applied to the instrument.

The internal battery may be monitored to verify operation as described below. A low battery will typically give errors when ac line power is removed and then re-applied. Any of the following errors may indicate a low battery:

- 201, “Memory lost: stored state”
- 202, “Memory lost: power-on state”
- 203, “Memory lost: stored measurements”
- 204, “Memory lost: time and date”

Verifying the capacity of the battery is recommended at the instrument’s annual calibration. If you need to verify or replace the battery on the DAQ970A/DAQ973A, be sure to unplug the instrument first. See “To verify or replace the battery” in the next section for more details.
To verify or replace the battery

1. Remove AC power cord.
2. Remove the instrument cover (see page 29).
3. Turn the instrument over and remove the battery.

4. Measure the battery voltage using an external DMM.
   Hold the red probe on the top (positive (+) side) of the battery and hold the black probe on the bottom (negative (–) side) of the battery. Replace the battery if the voltage is below 2.7 V.
   If the battery needs to be replaced, ensure that you install the new battery with its positive (+) side up. Dispose of the old battery in accordance with local regulations.

5. Replace the instrument cover, apply power, and turn the instrument on; the instrument will generate an error and beep (this is normal).

6. Set the date and time according to the procedures shown in the DAQ970A/DAQ973A User’s Guide.
Disassembly

The following tools are recommended for disassembly.

- T20 Torx® bit with 14 in-lbs electric torque driver (cover)
- T8 Torx® bit with 5 in-lbs electric torque driver (front panel)
- Torque driver 5 in-lbs with 5 mm hex socket (real panel connector)
- Manual torque driver 1 in-lbs (DMM assembly)

**WARNING**

**SHOCK HAZARD.**

Only service-trained personnel who are aware of the hazards involved should remove the instrument covers. Dangerous voltages may be encountered with the instrument covers removed.

**CAUTION**

To prevent damage to the fan, do not over tighten the fan screws.
General disassembly

1. 

2. 

3. 

4.
Internal DMM disassembly

1. Disconnect
2. Disconnect
3. Disconnect
Front panel disassembly

1.

2.

3.

4.

5.

Reverse side
Additional chassis disassembly

1. [Image of DAQ970A rear panel]
2. [Image of DAQ973A rear panel]
3. [Image of DAQ970A rear panel disassembled]
4. [Image of DAQ973A rear panel disassembled]
This section contains procedures for adjustment (calibration) of the instrument.

**Closed-case electronic calibration**  The instrument uses closed-case electronic calibration; no internal mechanical adjustments are required. The instrument requires the use of DAQM901A multiplexer module installed in slot 300 to interface input test connections from output sources (see “Recommended Test Equipment” on page 36). The instrument calculates correction factors based on reference signals that you apply and stores the correction factors in non-volatile EEPROM memory. Non-volatile EEPROM calibration memory does not change when power has been off, after a Factory Reset (*RST command), or after an Instrument Preset (SYSTem:PRESet command).
Keysight Technologies Calibration Service

When your instrument is due for calibration, contact your local Keysight Service Center for a low-cost recalibration. The DAQ970A/DAQ973A is supported on automated calibration systems which allow Keysight to provide this service at competitive prices.

Calibration Interval

The instrument should be calibrated on a regular interval determined by the measurement accuracy requirements of your application. A 1-year interval is adequate for most applications. Accuracy specifications are warranted only if adjustment is made at regular calibration intervals. Accuracy specifications are not warranted beyond the 1-year calibration interval. Keysight does not recommend extending calibration intervals beyond 2 years for any application.

Adjustment is recommended

Whatever calibration interval you select, Keysight recommends that complete re-adjustment should always be performed at the calibration interval. This will assure that the DAQ970A/DAQ973A will remain within specification for the next calibration interval. This criteria for re-adjustment provides the best long-term stability. Performance data measured using this method can be used to extend future calibration intervals.

Use the Calibration Count feature (see page 44) to verify that all adjustments have been performed.

Time Required for Calibration

The DAQ970A/DAQ973A can be automatically calibrated under computer control. With computer control you can perform the complete calibration procedure in less than 45 minutes and performance verification tests in less than 30 minutes once the instrument is warmed-up (see “Calibration Security” on page 39).
Automating Calibration Procedures

You can automate the complete verification and adjustment procedures outlined in this chapter if you have access to programmable test equipment. You can program the instrument configurations specified for each test over the remote interface. You can then enter readback verification data into a test program and compare the results to the appropriate test limit values.

You can also adjust the instrument from the remote interface. Remote adjustment is similar to the local front-panel procedure. You can use a computer to perform the adjustment by first selecting the required function and range. The calibration value is sent to the instrument and then the calibration is initiated over the remote interface. The instrument must be unsecured prior to initiating the calibration procedure.

For further information on programming the instrument, see the DAQ970A/DAQ973A Programming Guide.
Recommended Test Equipment

The test equipment recommended for the performance verification and adjustment procedures is listed below. If the exact instrument is not available, substitute calibration standards of equivalent accuracy.

A suggested alternate method would be to use the Keysight 3458A 8½-digit Digital Multimeter to measure less accurate yet stable sources. The output value measured from the source can be entered into the instrument as the target calibration value.

<table>
<thead>
<tr>
<th>Application[a]</th>
<th>Recommended equipment</th>
<th>Accuracy equipment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zero calibration</td>
<td>Low thermal offset wires</td>
<td>4-wire copper short</td>
</tr>
<tr>
<td>DC voltage</td>
<td>Fluke 5720A/5730A</td>
<td>&lt;1/5 instrument 24 hours specification</td>
</tr>
<tr>
<td>DC current</td>
<td>Fluke 5720A/5730A</td>
<td>&lt;1/5 instrument 24 hours specification</td>
</tr>
<tr>
<td>Resistance</td>
<td>Fluke 5720A/5730A</td>
<td>&lt;1/5 instrument 24 hours specification</td>
</tr>
<tr>
<td>AC voltage</td>
<td>Fluke 5720A/5730A</td>
<td>&lt;1/5 instrument 24 hours specification</td>
</tr>
<tr>
<td>AC current</td>
<td>Fluke 5720A/5730A</td>
<td>&lt;1/5 instrument 24 hours specification</td>
</tr>
<tr>
<td>Frequency</td>
<td>Keysight 33500B Series Function/Arbitrary Waveform Generator</td>
<td>&lt;1/5 instrument 24 hours specification</td>
</tr>
</tbody>
</table>

[a] In addition to the internal DMM, these applications require an input multiplexer module. The Keysight DAQM901A multiplexer module is recommended.
Input Connections

You will need the DAQM901A multiplexer module to verify or adjust the internal DMM. The DAQM901A multiplexer module should be connected in slot 300 with the following connections:

**Short (Zero)**

Zero test connections for the DAQM901A multiplexer module is best accomplished using 4-wire copper wires with low-thermal offset measurements. The 4-wire channels configured for the DAQM901A multiplexer module is channel $n$ and $n+10$.

- For DC voltage, 2-wire and 4-wire resistance, Channel 303 and 313 are used for zero test connections as illustrated below:

![Diagram showing channel connections](image)

- For DC current, Channel 321 is used for zero test and left OPEN.
Input test signal

Input test signal connections can be made using the DAQM901A multiplexer module to interface to the output sources (see “Recommended Test Equipment” on page 36). Shielded, twisted-pair, PTFE interconnect cables of minimum length are recommended between the calibrator and the DAQM901A multiplexer module channels to reduce settling and noise errors.

- HI and LO should be a twisted pair (Channel 302).
- HI-Sense and LO-Sense should be a twisted pair (Channel 312).
- AMPS and LO for DC/AC current should be a twisted pair (Channel 321).

All test cable shields should be tied to Input LO and ground referenced at the calibrator's output terminals. This configuration is recommended for noise reduction and settling time performance during calibration.
Calibration Security

This feature allows you to enter a security code to prevent accidental or unauthorized adjustments of the instrument. When you first receive your instrument, it is secured. Before you can adjust the instrument, you must unsecure it by entering the correct security code.

The procedures to enter the security code is described on page 40.

- The security code is set to “DAQ970A” when the instrument is shipped from the factory. The security code is stored in non-volatile memory, and does not change when power has been off, after a Factory Reset (*RST command), or after an Instrument Preset (SYSTem:PRESet command).

- The same security code must be used for front panel and remote operation. If you secure the instrument from the front panel, use that same code to unsecure it from the remote interface.

- The security code may contain up to 12 alphanumeric characters. The first character must be a letter, but the remaining characters can be letters, numbers, or an underscore ( _ ). You do not have to use all 12 characters but the first character must always be a letter.

NOTE

If you forget your security code, you can disable the security feature by adding a jumper inside the instrument as described on page 42.
To unsecure for calibration

You can unsecure the instrument either from the front panel or over the remote interface. The instrument is secured when shipped from the factory and the security code is set to “DAQ970A”.

*Front panel operation:*

2. To unsecure the instrument, press Secure Code.
   - After entering the correct security code, press Done. When you return to the menu, you will see new menu choices New Code, LOCK, and Secure (Off/On).
   - Refer to the DAQ970A/DAQ973A User’s Guide for more information on these new choices.
   - The System Security status now reads: *UNLOCKED*

*Remote interface operation:*

```
CALibration:SECure:STATe OFF, DAQ970A
```

**NOTE**

If you enter the wrong secure code, NO MATCH is displayed and a new choice, EXIT, is shown.

To secure against calibration

You can secure the instrument either from the front panel or over the remote interface. The instrument is secured when shipped from the factory and the security code is set to “DAQ970A”.

*Front panel operation:*

2. To secure the instrument, press LOCK. Press Yes to continue.
   - When you return to the menu, you will see that the System Security status now reads: *LOCKED*

*Remote interface operation:*

```
CALibration:SECure:STATe ON, DAQ970A
```
To change the security code

To change the security code, you must first unsecure the instrument, and then enter a new code. Make sure you have read the security code rules described on page 39 before attempting to change the security code.

Front panel operation:

1. To change the security code, first make sure that the instrument is unsecured. Press [Utility] > Security.
2. Press New Code, enter the new security code, and press Done.
3. Verify the new code, and press Yes to confirm the change.
4. Press LOCK to secure the instrument with the new code.

Remote interface operation:

CALibration:SECure:CODE <new_code>

Changing the code from the front panel also changes the code as seen from the remote interface.
To unsecure the instrument without the security code

To unsecure the instrument without the correct security code, follow the steps below. A front panel procedure to unsecure the instrument is given on page 40. See “Electrostatic discharge (ESD) precautions” on page 19 before beginning this procedure.

This procedure should be performed by qualified service personnel only. Turn off the power and remove all measurement leads and other cables, including the power cord, from the instrument before continuing.

1. Disassemble the instrument to remove the instrument cover (see page 29).
2. Turn the instrument over and locate the two exposed metal pads (TP601 and TP602) as shown below:

3. Apply a short between the two exposed metal pads (TP601 and TP602) using a jumper wire.
4. Replace the instrument cover, apply power, and turn the instrument on; the instrument will generate an error and beep (this is normal). Wait 30 to 40 seconds for the instrument to power up completely.
5  Reset the security code to the factory default:
   b  Enter “DAQ970A” as the new passcode.
   c  Press Done.
   d  Verify the new code, and press Yes to confirm the change.
6  Disconnect the power cord, disassemble the instrument, and remove the jumper wire applied in step 3.
7  Reassemble the instrument.
Calibration Message

The instrument allows you to store one message in calibration memory. For example, you can store such information as the date when the last calibration was performed, the date when the next calibration is due, the instrument’s serial number, or even the name and phone number of the person to contact for a new calibration.

- You can record a calibration message from either the front-panel or over the remote interface only when the instrument is unsecured.
- You can read the calibration message from either the front-panel or over the remote interface whether the instrument is secured or unsecured.
- The calibration message may contain up to 40 characters.
- To read the calibration message, press [Utility] > Calibrate or send CALibration:STRing? from the remote interface.
- To change the calibration message, unsecure the instrument and press [Utility] > Calibrate > Edit Cal String or send CALibration:STRing "<string>" from the remote interface.

Calibration Count

You can query the instrument to determine how many calibrations have been performed. Because the value increments each time you store the calibration constants, a complete calibration adds many counts. The calibration count also increments whenever you save a calibration string, change the calibration password, or override the calibration security.

Note that your instrument was calibrated before it left the factory. When you receive your instrument, be sure to read the count to determine its initial value.

To read the calibration count, press [Utility] > Calibrate on the front panel or send CALibration:COUNt? from the remote interface. You can read the calibration count whether the instrument is secured or unsecured.
Recommended Calibration Procedure

The following procedure is the recommended method to complete an instrument calibration.

1. Read the “Test Considerations” on page 47.
2. Unsecure the instrument for calibration (see page 40).
3. Perform the verification tests to characterize the instrument (incoming data).
4. Perform the zero and ADC calibration procedure (see page 52).
5. Perform the gain adjustment procedures (see page 55).
6. Perform the verification tests to verify the adjustments (outgoing data).
7. Secure the instrument against calibration (see page 40).
8. Note the new security code and calibration count in the instrument’s maintenance records (see page 44).

Aborting a Calibration in Progress

Sometimes it may be necessary to abort a calibration after the procedure has already been initiated. You can abort a calibration at any time by turning off the power. When performing a calibration from the remote interface, you can abort a calibration by issuing a remote interface device clear message.

CAUTION

If you abort a calibration in progress when the instrument is attempting to write new calibration constants to EEPROM, you may lose all calibration constants for the function. Typically, upon re-applying power, the instrument will report error 705 Cal:Aborted. You may also generate errors 740 through 746. If this occurs, you should not use the instrument until a complete re-adjustment has been performed.
Calibration Actions

Entering calibration values

Use measurement commands to set the instrument's measurement parameters and functions for the mode being calibrated, then enter calibration values with the following:

*Front panel operation:*

- `[Utility] > Calibrate > Cal Value`

  After specifying the input value for the calibration step to be performed, press *Perform Cal Step*.

*Remote interface operation:*

- Enter cal value: `CALibration:VALue <value>`
- Perform calibration: `CALibration[:ALL]?`

Storing calibration constants

To store calibration values in non-volatile memory, use the following:

*Front panel operation: `[Utility] > Calibrate > Save Cal Values`

*Remote interface operation: `CALibration:STORe`
Test Considerations

Errors may be induced by AC signals present on the input leads during a self–test. Long test leads can also act as an antenna causing pick–up of AC signals. For optimum performance, all procedures should comply with the following recommendations:

Environmental conditions

- Assure that the calibration ambient temperature ($T_{\text{cal}}$) is stable and between $18 \, ^\circ\text{C}$ and $28 \, ^\circ\text{C}$. Ideally the calibration should be performed at $23 \, ^\circ\text{C} \pm 1 \, ^\circ\text{C}$.
- Assure that the ambient relative humidity is less than 80%.
- Allow at least a 60-minute warm–up period with a 4–wire copper short and the 5–wire input test signal cable connected to the respective channels in the DAQM901A multiplexer module installed in slot 300 before verification or adjustment. For more information, see "Input Connections" on page 37.
Calibrator setup

Connect the input cable shields to earth ground by connecting the calibrator's output LO terminal to earth GROUND at the calibrator. It is important that the LO to earth ground connection can be made at only one place in the circuit to avoid ground loops as shown in following image:

The V-GUARD terminal is connected to the GROUND terminal via the shorting bar, and the output LO terminal is connected to the GROUND terminal with a wire (Lug on the LO terminal, alligator clip to the shorting bar). This is mandatory for low current measurements.

- Allow at least a 60-minute warm-up period for Fluke calibrator to stabilize.
- Perform DC zero calibration (it takes approximately 2.5 minutes to complete) from the front panel at least once every 30 days to ensure its performance accuracy.
- Allow for appropriate source settling by ensuring that the "U" annunciator disappears after enabling the output or by ensuring bit 12 (SETTLED) of the calibrator's Instrument Status Register (ISR?) is set to 1.
- For 2-wire ohms gain measurements, remove the test leads resistance by doing a Math NULL measurement with the leads shorted at Fluke Calibrator's 0 Ω (short).

Channel delay

The Open/Close characteristics of the physical relays in the DAQM901A multiplexer module require delay time for the input test signals to settle before valid and accurate measurements can be triggered by the internal DMM.

Depending on the length of the input test cables, set the channel delay time for the instrument's respective measurement functions and ranges:

<table>
<thead>
<tr>
<th>Measurement function</th>
<th>Input range</th>
<th>Input test cable length</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>≤1 meter</td>
</tr>
<tr>
<td>DC voltage</td>
<td>≤100 V</td>
<td>Auto</td>
</tr>
<tr>
<td></td>
<td>&gt;100 V</td>
<td>Auto</td>
</tr>
<tr>
<td>DC current</td>
<td>All</td>
<td>Auto</td>
</tr>
<tr>
<td>AC voltage</td>
<td>All</td>
<td>Auto</td>
</tr>
<tr>
<td>AC current</td>
<td>All</td>
<td>Auto</td>
</tr>
<tr>
<td>4-wire ohms[a]</td>
<td>≤100 Ω</td>
<td>Auto</td>
</tr>
<tr>
<td></td>
<td>≤1 kΩ</td>
<td></td>
</tr>
<tr>
<td></td>
<td>≤10 kΩ</td>
<td></td>
</tr>
<tr>
<td></td>
<td>≤100 kΩ</td>
<td></td>
</tr>
<tr>
<td></td>
<td>≤1 MΩ</td>
<td></td>
</tr>
<tr>
<td></td>
<td>≥10 MΩ</td>
<td></td>
</tr>
<tr>
<td>2-wire ohms</td>
<td>All</td>
<td>Auto</td>
</tr>
<tr>
<td>Frequency</td>
<td>All</td>
<td>Auto</td>
</tr>
<tr>
<td>Capacitance</td>
<td>All</td>
<td>Auto</td>
</tr>
</tbody>
</table>

[a] The additional delay times for varying input ranges are needed for the instrument's test current source to stabilize for test leads > 1 meter in length during ohms measurement, especially as the range increases, the test current source decreases, which is particularly sensitive to environmental changes.
Front panel operation:

Press [Channel] > Measure. Select the measurement function on the selected channel, then press Done. Press Advanced > Delay (Auto or Time).

Remote interface operation:

Auto delay: ROUTe:CHANnel:DELay:AUTO {OFF|ON} [, (@<ch_list>)]
Manual delay: ROUTe:CHANnel:DELay {<seconds> | MIN | MAX | DEF} [, (@<ch_list>)]

Channel monitor

You can use the Monitor function to continuously take readings on a single channel, even during a scan. This feature is used during front panel calibration procedures.

Front panel operation:

Select the channel to be monitored using the knob or arrow keys. Only one channel can be monitored at a time but you can change the channel being monitored at any time by turning the knob or pressing the up/down arrow key.

Press [Monitor] on the selected channel. Any channel that can be “read” by the instrument can be monitored (the Monitor annunciator turns on). This includes any combination of temperature, voltage, resistance, current, frequency, or period measurements on multiplexer channels. You can also monitor a digital input port or the totalizer count on the multifunction module. To disable monitoring, press [Monitor] key again on the Monitor menu page.

Remote interface operation:

To select channel for monitor: ROUTe:MONitor (@<channel>)
To enable/disable channel monitor: ROUTe:MONitor:STATe {OFF|ON}
Calibration Adjustment Sequence

Given the sensitivity of the 6.5 digits internal DMM within the DAQ970A/DAQ973A, it is imperative to follow the calibration sequence as stated below:

<table>
<thead>
<tr>
<th>Sequence</th>
<th>Functions</th>
<th>Section</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Zero and ADC calibration</td>
<td>Zero adjustment</td>
</tr>
<tr>
<td>2</td>
<td>AC voltage low frequency gain and flatness calibration</td>
<td>Gain adjustment</td>
</tr>
<tr>
<td>3</td>
<td>AC voltage gain and flatness calibration</td>
<td>Gain adjustment</td>
</tr>
<tr>
<td>4</td>
<td>AC current gain and flatness calibration</td>
<td>Gain adjustment</td>
</tr>
<tr>
<td>5</td>
<td>AC zero calibration</td>
<td>Zero adjustment</td>
</tr>
<tr>
<td>6</td>
<td>Frequency accuracy calibration</td>
<td>Gain adjustment</td>
</tr>
<tr>
<td>7</td>
<td>DC voltage gain calibration (≤10 V)</td>
<td>Gain adjustment</td>
</tr>
<tr>
<td>8</td>
<td>Ohms gain calibration (4-wire and 2-wire)</td>
<td>Gain adjustment</td>
</tr>
<tr>
<td>9</td>
<td>DC current gain calibration</td>
<td>Gain adjustment</td>
</tr>
<tr>
<td>10</td>
<td>DC high voltage gain calibration (≥100 V)</td>
<td>Gain adjustment</td>
</tr>
<tr>
<td>11</td>
<td>Capacitance zero calibration</td>
<td>Zero adjustment</td>
</tr>
</tbody>
</table>

Internal DMM Adjustments

The DAQM901A multiplexer module will be needed to perform the following procedures. The module must be installed in slot 300.
Zero Adjustment

Each time you perform a zero adjustment, the Internal DMM stores a new set of offset correction constants for every measurement function and range. The Internal DMM will sequence through all required functions and ranges automatically and store new zero offset calibration constants. All offset corrections are determined automatically. You may not correct a single range or function without re-entering ALL zero offset correction constants automatically. This feature is intended to save calibration time and improve zero calibration consistency.

**NOTE**

Never turn off the instrument during zero adjustment. This may cause ALL calibration memory to be lost.

Zero and ADC calibration

This zero and ADC adjustment procedure takes about 2 minutes to complete.

1. Ensure that you have read “Test Considerations” on page 47 before beginning this test.

2. Ensure that you follow the sequence listed in the “Calibration Adjustment Sequence” on page 51.

3. This procedure will use the copper shorts installed on Channels 303 and 313. Leave the amps input connections (Channel 321) open.

4. Select Channel 303 and configure the function to Ohms 4W, auto range, and NPLC 10.

5. Enable Channel Monitor on the selected channel before each test (see “Channel monitor” on page 50).

6. Enter a calibration value of +0 and press Perform Cal Step to begin the adjustment procedure (see “Entering calibration values” on page 46).

7. The zero calibration lasts approximately 1 minute. A “Calibration Step Succeeded” message indicates success; if the display shows “Calibration Step Failed”, check the input value, range, function, and entered calibration value, and repeat the calibration step.

8. Press Perform ADC Cal to initiate the ADC calibration.
9 The display will show a message indicating that ADC calibration is in process. It will then display the results of the ADC calibration. A “Calibration Step Succeeded” message indicates success; if the display shows “Calibration Step Failed”, check the input value, range, function, and entered calibration value, and repeat the calibration step.

10 Store the new zero and ADC calibration constants (see “Storing calibration constants” on page 46).

AC zero calibration

1 Ensure that you have read “Test Considerations” on page 47 before beginning this test.

2 Ensure that you follow the sequence listed in the “Calibration Adjustment Sequence” on page 51.

3 This procedure will use the copper short installed on Channel 303.

4 Select Channel 303 and configure the function to AC voltage, 1 V range, and AC filter (20 Hz).

5 Enable Channel Monitor on the selected channel before each test (see “Channel monitor” on page 50).

6 Enter a calibration value of +0 and press Perform Cal Step to begin the adjustment procedure (see “Entering calibration values” on page 46).

7 The AC zero calibration lasts approximately 10 seconds. A “Calibration Step Succeeded” message indicates success; if the display shows “Calibration Step Failed”, check the input value, range, function, and entered calibration value, and repeat the calibration step.

8 Store the new AC zero calibration constants (see “Storing calibration constants” on page 46).
Capacitance zero calibration

1. Ensure that you have read “Test Considerations” on page 47 before beginning this test.

2. Ensure that you follow the sequence listed in the “Calibration Adjustment Sequence” on page 51.

3. This procedure will use an open Channel 318.

4. Select Channel 318 and configure the function to Capacitance, 1 nF range.

5. Enable Channel Monitor on the selected channel before each test (see “Channel monitor” on page 50).

6. Enter a calibration value of +0 and press Perform Cal Step to begin the adjustment procedure (see “Entering calibration values” on page 46).

7. The capacitance zero calibration lasts approximately 1 minute. A “Calibration Step Succeeded” message indicates success; if the display shows “Calibration Step Failed”, check the input value, range, function, and entered calibration value, and repeat the calibration step.

8. Store the new capacitance zero calibration constants (see “Storing calibration constants” on page 46).
Gain Adjustment

The DAQ970A/DAQ973A stores a single new gain correction constant each time this procedure is followed. The gain constant is computed from the calibration value entered for the calibration command and from measurements made automatically during the adjustment procedure.

Most measuring functions and ranges have gain adjustment procedures. Only diode, capacitance, 1 μA, 10 μA, and 100 μA current ranges do not have gain calibration procedures. The gain calibration value may be entered through the front panel menu or over the remote interface.

Adjustments for each function should be performed ONLY in the order shown in “Calibration Adjustment Sequence” on page 51.

Gain and flatness adjustment considerations

- The ADC and zero adjustment procedure must have been recently performed prior to beginning any gain adjustment procedures.
- When performing a 4-wire ohms gain adjustment, a new gain correction constant is also stored for the corresponding 2-wire ohms measurement range.
- The instrument calculates and stores gain corrections for each input value. The gain constant is computed from the calibration value entered for the calibration command and from measurements made automatically during the calibration procedure.
- The instrument stores new flatness correction constants each time this procedure is followed. Flatness constants adjust the internal DMM for AC volts and AC current measurements across the usable input frequency band. The flatness constant is computed from the calibration value entered for the calibration command and from measurements made automatically during the calibration procedure.

**NOTE**

Never turn off the instrument during a gain adjustment. This may cause ALL calibration memory for the present function to be lost.
Valid gain adjustment input values

Gain calibration can be accomplished using the following input values:

<table>
<thead>
<tr>
<th>Function</th>
<th>Range</th>
<th>Valid amplitude input values</th>
</tr>
</thead>
<tbody>
<tr>
<td>DC voltage</td>
<td>100 mV to 100 V</td>
<td>0.9 to 1.1 x Full Scale</td>
</tr>
<tr>
<td></td>
<td>300V</td>
<td>0.9 to 1.0 x Full Scale</td>
</tr>
<tr>
<td>DC current</td>
<td>1 mA to 1 A</td>
<td>0.9 to 1.1 x Full Scale</td>
</tr>
<tr>
<td>Ohms 2W and 4W</td>
<td>100 Ω to 100 MΩ</td>
<td>0.9 to 1.1 x Full Scale</td>
</tr>
<tr>
<td>AC voltage RMS[^a]</td>
<td>100 mV to 100 V</td>
<td>0.9 to 1.1 x Full Scale</td>
</tr>
<tr>
<td></td>
<td>300V</td>
<td>0.9 to 1.0 x Full Scale</td>
</tr>
<tr>
<td>AC current RMS[^a]</td>
<td>100 μA to 1 A</td>
<td>0.9 to 1.1 x Full Scale</td>
</tr>
<tr>
<td>Frequency</td>
<td>Auto</td>
<td>Input &gt;100 mV rms, 1 kHz to 100 kHz</td>
</tr>
</tbody>
</table>

[^a] Valid frequencies are nominal frequencies ±1%.

AC voltage low frequency gain and flatness calibration

1. Ensure that you have read the “Test Considerations” on page 47 and the “Gain and flatness adjustment considerations” on page 55.

2. Ensure that you follow the sequence listed in the “Calibration Adjustment Sequence” on page 51.

3. This procedure will measure and adjust the input signal from the calibrator source connected to Channel 302 (AC voltage). See the connections in “Input test signal” on page 38.

4. Select Channel 302 and configure the function in the order shown in the table below and enable Channel Monitor on the selected channel before each test (see “Channel monitor” on page 50).

5. Apply the input voltage per the input column in Table 2-1 and allow for appropriate source settling.

6. Enter the calibration value per the applied input voltage in step 5 and press Perform Cal Step to begin the adjustment procedure (see “Entering calibration values” on page 46).
A “Calibration Step Succeeded” message indicates success; if the display shows “Calibration Step Failed”, check the input value, range, function, and entered calibration value, and repeat the calibration step.

Repeat step 5 to step 7 for each frequency in the following table.

Store the new gain and flatness calibration constants (see “Storing calibration constants” on page 46).

Table 2-1  AC voltage low frequency gain and flatness calibration

<table>
<thead>
<tr>
<th>Input</th>
<th>Channel 302</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voltage (V)</td>
<td>Frequency (Hz)</td>
</tr>
<tr>
<td>7</td>
<td>10 Hz, 40 Hz</td>
</tr>
</tbody>
</table>

AC voltage gain and flatness calibration

1 Ensure that you have read the “Test Considerations” on page 47 and the “Gain and flatness adjustment considerations” on page 55.

2 Ensure that you follow the sequence listed in the “Calibration Adjustment Sequence” on page 51.

3 This procedure will measure and adjust the input signal from the calibrator source connected to Channel 302 (AC voltage). See the connections in “Input test signal” on page 38.

4 Select Channel 302 and configure the function in the order shown in the table below and enable Channel Monitor on the selected channel before each test (see “Channel monitor” on page 50).

5 Apply the input voltage per the input column in Table 2-2 and allow for appropriate source settling.

6 Enter the calibration value per the applied input voltage in step 5 and press Perform Cal Step to begin the adjustment procedure (see “Entering calibration values” on page 46).

7 A “Calibration Step Succeeded” message indicates success; if the display shows “Calibration Step Failed”, check the input value, range, function, and entered calibration value, and repeat the calibration step.

8 Repeat step 5 to step 7 for each frequency in the following table.
9 Repeat step 5 to step 8 for each voltage in the following table.

10 Store the new gain and flatness calibration constants (see “Storing calibration constants” on page 46).

**Table 2-2 AC voltage gain and flatness calibration**

<table>
<thead>
<tr>
<th>Voltage</th>
<th>Frequency</th>
<th>Function</th>
<th>Range</th>
<th>AC filter</th>
</tr>
</thead>
<tbody>
<tr>
<td>100 mV</td>
<td>5 kHz</td>
<td>AC voltage</td>
<td>100 mV</td>
<td></td>
</tr>
<tr>
<td></td>
<td>10 kHz</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>20 kHz</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1 V</td>
<td>35 kHz</td>
<td></td>
<td>1 V</td>
<td>&gt;3 Hz</td>
</tr>
<tr>
<td></td>
<td>50 kHz</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10 V</td>
<td>200 kHz</td>
<td></td>
<td>10 V</td>
<td></td>
</tr>
<tr>
<td></td>
<td>300 kHz</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>50 V</td>
<td>390 kHz</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>400 kHz</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>220 Hz</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>220 Hz</td>
<td>1 kHz</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>200 V</td>
<td>1 kHz</td>
<td></td>
<td>300 V</td>
<td></td>
</tr>
</tbody>
</table>

**AC current gain and flatness calibration**

1 Ensure that you have read the “Test Considerations” on page 47 and the “Gain and flatness adjustment considerations” on page 55.

2 Ensure that you follow the sequence listed in the “Calibration Adjustment Sequence” on page 51.

3 This procedure will measure and adjust the input signal from the calibrator source connected to Channel 321 (AC current). See the connections in “Input test signal” on page 38.

4 Select Channel 321 and configure the function in the order shown in the table below and enable Channel Monitor on the selected channel before each test (see “Channel monitor” on page 50).

5 Apply the input current per the input column in Table 2-3 and allow for appropriate source settling.

6 Enter the calibration value per the applied input current in step 5 and press Perform Cal Step to begin the adjustment procedure (see “Entering calibration values” on page 46).
7 A “Calibration Step Succeeded” message indicates success; if the display shows “Calibration Step Failed”, check the input value, range, function, and entered calibration value, and repeat the calibration step.

8 Repeat step 5 to step 7 for each frequency in the following table.

9 Repeat step 5 to step 8 for each current in the following table.

10 Store the new gain and flatness calibration constants (see “Storing calibration constants” on page 46).

### Table 2-3 AC current gain and flatness calibration

<table>
<thead>
<tr>
<th>Input</th>
<th>Channel 321</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current</td>
<td>Frequency</td>
</tr>
</tbody>
</table>
| 1 A      | 5 kHz | 7.5 kHz | 9.7 kHz | 10 kHz | 220 Hz | 1 kHz | 1 A
| 100 mA   | 5 kHz | 7.5 kHz | 9.7 kHz | 10 kHz | 220 Hz | 1 kHz | 100 mA
| 10 mA    | 9.7 kHz | 10 kHz | 220 Hz | 1 kHz | 100 mA |
| 1 mA     | 220 Hz | 1 kHz | AC current | 10 mA |
| 100 μA   | 100 μA |

### Frequency accuracy calibration

1 Ensure that you have read the “Test Considerations” on page 47 and the “Gain and flatness adjustment considerations” on page 55.

2 Ensure that you follow the sequence listed in the “Calibration Adjustment Sequence” on page 51.

3 This procedure will measure and adjust the input signal from the calibrator source connected to Channel 302 (Frequency). See the connections in “Input test signal” on page 38.

4 Select **Channel 302** and configure the function in the order shown in the table below and enable **Channel Monitor** on the selected channel before each test (see “Channel monitor” on page 50).

5 Apply the input signal per the input column in Table 2-4 and allow for appropriate source settling.
6 Enter the calibration value per the applied input current in step 5 and press Perform Cal Step to begin the adjustment procedure (see “Entering calibration values” on page 46).

7 A “Calibration Step Succeeded” message indicates success; if the display shows “Calibration Step Failed”, check the input value, range, function, and entered calibration value, and repeat the calibration step.

8 Store the new gain and flatness calibration constants (see “Storing calibration constants” on page 46).

### Table 2-4 Frequency accuracy calibration

<table>
<thead>
<tr>
<th>Input</th>
<th>Channel 302</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vrms[\textsuperscript{a}]</td>
<td>Frequency</td>
</tr>
<tr>
<td>10 V</td>
<td>10 kHz</td>
</tr>
</tbody>
</table>

[\textsuperscript{a}] Keysight 33500B Series function/arbitrary waveform generator: Select Function to \textit{Square Wave}, Output Load to \textit{High Impedance} (INF).

**DC voltage gain calibration (≤10 V)**

1 Ensure that you have read the “Test Considerations” on page 47 and the “Gain and flatness adjustment considerations” on page 55.

2 Ensure that you follow the sequence listed in the “Calibration Adjustment Sequence” on page 51.

3 This procedure will measure and adjust the input signal from the calibrator source connected to Channel 302 (DC voltage). See the connections in “Input test signal” on page 38.

4 Select Channel 302 and configure the function in the order shown in the table below and enable Channel Monitor on the selected channel before each test (see “Channel monitor” on page 50).

5 Apply the input voltage per the input column in Table 2-5 and allow for appropriate source settling.

6 Enter the calibration value per the applied input current in step 5 and press Perform Cal Step to begin the adjustment procedure (see “Entering calibration values” on page 46).
7 A “Calibration Step Succeeded” message indicates success; if the display shows “Calibration Step Failed”, check the input value, range, function, and entered calibration value, and repeat the calibration step.

8 Repeat step 5 to step 7 for each gain calibration point.

9 Store the new gain calibration constants (see “Storing calibration constants” on page 46).

### Table 2-5  DC voltage gain calibration (≤10 V)

<table>
<thead>
<tr>
<th>Voltage</th>
<th>Function</th>
<th>Range</th>
<th>NPLC</th>
</tr>
</thead>
<tbody>
<tr>
<td>10 V</td>
<td>DC voltage</td>
<td>10 V</td>
<td></td>
</tr>
<tr>
<td>-10 V</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>100 mV</td>
<td>DC voltage</td>
<td>100 mV</td>
<td>10</td>
</tr>
<tr>
<td>-100 mV</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1 V</td>
<td></td>
<td>1 V</td>
<td></td>
</tr>
</tbody>
</table>

Ohms gain calibration (2-wire and 4-wire)

1 Ensure that you have read the “Test Considerations” on page 47 and the “Gain and flatness adjustment considerations” on page 55.

2 Ensure that you follow the sequence listed in the “Calibration Adjustment Sequence” on page 51.

3 This procedure will measure and adjust the input signal from the calibrator source connected to Channel 302 (Ohms). See the connections in “Input test signal” on page 38.

4 Select Channel 302 and configure the function in the order shown in the table below and enable Channel Monitor on the selected channel before each test (see “Channel monitor” on page 50).

5 Apply the input resistance per the input column in Table 2-6 and allow for appropriate source settling.

6 Enter the calibration value per the applied input current in step 5 and press Perform Cal Step to begin the adjustment procedure (see “Entering calibration values” on page 46).
7. A “Calibration Step Succeeded” message indicates success; if the display shows “Calibration Step Failed”, check the input value, range, function, and entered calibration value, and repeat the calibration step.

8. Repeat step 5 to step 7 for each gain calibration point.

9. Store the new gain calibration constants (see “Storing calibration constants” on page 46).

### Table 2-6 Ohms gain calibration (2-wire and 4-wire)

<table>
<thead>
<tr>
<th>Input</th>
<th>Channel 302</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ohms</td>
<td>Function</td>
</tr>
<tr>
<td>100 Ω</td>
<td></td>
</tr>
<tr>
<td>1 kΩ</td>
<td></td>
</tr>
<tr>
<td>10 kΩ</td>
<td>4-wire ohms</td>
</tr>
<tr>
<td>100 kΩ</td>
<td></td>
</tr>
<tr>
<td>1 MΩ</td>
<td></td>
</tr>
<tr>
<td>10 MΩ</td>
<td></td>
</tr>
<tr>
<td>100 MΩ</td>
<td>2-wire ohms</td>
</tr>
</tbody>
</table>

[a] Fluke 5720A/5730A Calibrator: Enable [EX SNS] (external sense) for 4-wire ohms measurements.

### DC current gain calibration

1. Ensure that you have read the “Test Considerations” on page 47 and the “Gain and flatness adjustment considerations” on page 55.

2. Ensure that you follow the sequence listed in the “Calibration Adjustment Sequence” on page 51.

3. This procedure will measure and adjust the input signal from the calibrator source connected to Channel 321 (DC current). See the connections in “Input test signal” on page 38.

4. Select **Channel 321** and configure the function in the order shown in the table below and enable **Channel Monitor** on the selected channel before each test (see “Channel monitor” on page 50).
5 Apply the input current per the input column in Table 2-7 and allow for appropriate source settling.

6 Enter the calibration value per the applied input current in step 5 and press Perform Cal Step to begin the adjustment procedure (see “Entering calibration values” on page 46).

7 A “Calibration Step Succeeded” message indicates success; if the display shows “Calibration Step Failed”, check the input value, range, function, and entered calibration value, and repeat the calibration step.

8 Repeat step 5 to step 7 for each calibration point.

9 Store the new gain and flatness calibration constants (see “Storing calibration constants” on page 46).

### Table 2-7 DC current gain calibration

<table>
<thead>
<tr>
<th>Input</th>
<th>Channel 321</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current</td>
<td>Function</td>
</tr>
<tr>
<td>1 mA</td>
<td>DC current</td>
</tr>
<tr>
<td>10 mA</td>
<td>DC current</td>
</tr>
<tr>
<td>100 mA</td>
<td>DC current</td>
</tr>
<tr>
<td>1 A</td>
<td></td>
</tr>
</tbody>
</table>

DC high voltage gain calibration (≥100 V)

1 Ensure that you have read the “Test Considerations” on page 47 and the “Gain and flatness adjustment considerations” on page 55.

2 Ensure that you follow the sequence listed in the “Calibration Adjustment Sequence” on page 51.

3 This procedure will measure and adjust the input signal from the calibrator source connected to Channel 302 (DC voltage). See the connections in “Input test signal” on page 38.

4 Select Channel 302 and configure the function in the order shown in the table below and enable Channel Monitor on the selected channel before each test (see “Channel monitor” on page 50).
5 Apply the input voltage per the input column in Table 2-8 and allow for appropriate source settling.

6 Enter the calibration value per the applied input current in step 5 and press **Perform Cal Step** to begin the adjustment procedure (see “Entering calibration values” on page 46).

7 A “Calibration Step Succeeded” message indicates success; if the display shows “Calibration Step Failed”, check the input value, range, function, and entered calibration value, and repeat the calibration step.

8 Repeat step 5 to step 7 for each gain calibration point.

9 Store the new gain calibration constants (see “Storing calibration constants” on page 46).

**Table 2-8**  
DC high voltage gain calibration (≥100 V)

<table>
<thead>
<tr>
<th>Voltage</th>
<th>Function</th>
<th>Range</th>
<th>NPLC</th>
</tr>
</thead>
<tbody>
<tr>
<td>100 V</td>
<td>DC voltage</td>
<td>100 V</td>
<td>10</td>
</tr>
<tr>
<td>221 V</td>
<td></td>
<td>300 V</td>
<td></td>
</tr>
</tbody>
</table>
3 Performance Verification

Quick Performance Check  66
Performance Verification Tests  67
Internal DMM Verification Tests  68
Zero Offset Verification  68
Gain Verification  70
Plug-in Module Test Considerations  76
Relay Verification  78
DAQM907A Analog Output Verification (Optional)  92
DAQM907A Analog Sense Inputs Verification (Optional)  93
Thermocouple Reference Junction Verification (Optional)  94
DAQM909A DC/AC Coupling Verification (Optional)  95

This chapter verifies the measurement performance of the instrument using the instrument’s specifications listed in the product data sheet.
Quick Performance Check

The quick performance check is a combination of internal self-test and an abbreviated performance test (specified by the letter Q in the performance verification tests). This provides a simple method to achieve high confidence in the instrument’s ability to functionally operate and meet specifications. These tests represent the absolute minimum set of performance checks recommended following any service activity. Auditing the instrument’s performance for the quick check points (designated by a Q) verifies performance for “normal” accuracy drift mechanisms. This test does not check for abnormal component failures.

To perform the quick performance check, do the following:

- Perform a self-test (see page 23).
- Perform only the performance verification tests indicated with the letter Q.
Performance Verification Tests

To ensure optimal test performance:

- Please perform an Autocalibration before you conduct the performance verification test.
- Ensure all procedures comply with the recommend test conditions. Please refer to “Test Considerations” on page 47 for more information.

The performance verification tests are recommended as acceptance tests when you first receive the instrument. The acceptance test results should be compared against the 90-days test limits. You should use the 24-hours test limits only for verification within 24 hours after performing the adjustment procedure. After acceptance, you should repeat the performance verification tests at every calibration interval.

If the instrument fails performance verification, adjustment or repair is required.

Adjustment is recommended at every calibration interval. If adjustment is not made, you must guard band, using no more than 80% of the specifications listed in product data sheet, depending on the calibration interval (1 year, 2 year), as the verification limits.

Use the Performance Verification Tests to verify the measurement performance of the instrument. The performance verification tests use the instrument’s specifications listed in product data sheet. You can perform four different levels of performance verification tests:

- **Self-test**: A series of internal verification tests that give a high confidence that the instrument is operational.
- **Quick verification**: A combination of the internal self-tests and selected verification tests.
- **Performance verification tests**: An extensive set of tests that are recommended as an acceptance test when you first receive the instrument or after performing adjustments.
- **Optional verification tests**: Tests not performed with every calibration. Perform these tests to verify additional specifications or functions of the instrument.
Internal DMM Verification Tests

These procedures use inputs connected to a DAQM901A multiplexer module installed in slot 300. For more information, see “Input Connections” on page 37.

Zero Offset Verification

This procedure is used to check the zero offset performance of the internal DMM. Verification checks are only performed for those functions and ranges with unique offset calibration constants. Measurements are checked for each function and range as described in the procedure below:

1. Ensure that you have read the “Test Considerations” on page 47.

2. This procedure will measure the shorts installed on Channels 303 and 313. Leave the amps input connections (Channel 321) open. See the connections in “Short (Zero)” on page 37.

3. Select each function and range in the order shown in following table. Enable Channel Monitor on the selected channel before each test (see “Channel monitor” on page 50).

4. Compare the measurement results to the appropriate test limits.

NOTE

Zero offset calibration using a multifunction calibration is NOT recommended. The calibrator and cabling offset can be large and unstable causing poor offset calibration of the internal DMM.

<table>
<thead>
<tr>
<th>Input</th>
<th>Channel 303</th>
<th>Quick check</th>
<th>Error from nominal</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Function[b]</td>
<td>Range</td>
<td>24 hours</td>
</tr>
<tr>
<td>Short</td>
<td>DC voltage</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>100 mV</td>
<td>Q</td>
<td>±5 μV</td>
</tr>
<tr>
<td></td>
<td>1 V</td>
<td></td>
<td>±6 μV</td>
</tr>
<tr>
<td></td>
<td>10 V</td>
<td></td>
<td>±30 μV</td>
</tr>
<tr>
<td></td>
<td>100 V</td>
<td></td>
<td>±600 μV</td>
</tr>
<tr>
<td></td>
<td>300 V</td>
<td></td>
<td>±6 mV</td>
</tr>
</tbody>
</table>
### Performance Verification

<table>
<thead>
<tr>
<th>Input</th>
<th>Channel 303</th>
<th>Quick check[a]</th>
<th>Error from nominal</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Function[b]</td>
<td>Range</td>
<td>24 hours</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4-wire ohms</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>100 Ω</td>
<td>±5 mΩ</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 kΩ</td>
<td>±7 mΩ</td>
</tr>
<tr>
<td></td>
<td></td>
<td>10 kΩ Q</td>
<td>±50 mΩ</td>
</tr>
<tr>
<td></td>
<td></td>
<td>100 kΩ</td>
<td>±500 mΩ</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 MΩ</td>
<td>±5 Ω</td>
</tr>
<tr>
<td></td>
<td></td>
<td>10 MΩ</td>
<td>±100 Ω</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2-wire ohms[c]</td>
<td>100 MΩ[d]</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1000 MΩ[d]</td>
<td>±10 kΩ</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Input</th>
<th>Channel 321</th>
<th>Quick check[a]</th>
<th>Error from nominal</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Function[b]</td>
<td>Range</td>
<td>24 hours</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Open DC current</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 A</td>
<td>±60 μA</td>
</tr>
<tr>
<td></td>
<td></td>
<td>100 mA</td>
<td>±4 μA</td>
</tr>
<tr>
<td></td>
<td></td>
<td>10 mA</td>
<td>±2 μA</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 mA</td>
<td>±30 nA</td>
</tr>
<tr>
<td></td>
<td></td>
<td>100 μA[c] Q</td>
<td>±1 nA</td>
</tr>
<tr>
<td></td>
<td></td>
<td>10 μA[c]</td>
<td>±200 pA</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 μA[c]</td>
<td>±50 pA</td>
</tr>
</tbody>
</table>

[a] Q: Quick performance verification test points.
[b] For Channel 303, select NPLC 10.
[c] For 2-wire ohms, use Math NULL, otherwise an additional 2 Ω error must be added.
[d] The 100 MΩ and 1000 MΩ ranges are for 2-wire ohms only.

---

Keysight DAQ970A/DAQ973A Service Guide 69
Gain Verification

This procedure is used to check the “full scale” reading accuracy of the internal DMM. Verification checks are performed only for those functions and ranges with unique gain calibration constants. Measurements are checked for each function and range as described in the procedure below:

**DC voltage, ohms, and DC current gain verification**

1. Ensure that you have read the “Test Considerations” on page 47.
2. This procedure will measure the input signal from the Fluke calibrator source connected to Channel 302 (DC voltage, 2-wire ohms), 312 (4-wire ohms), and 321 (DC current). See the connections in “Input test signal” on page 38.
3. Configure each function and range to the respective channel in the order shown in following tables. Enable Channel Monitor on the selected channel before each test (see “Channel monitor” on page 50).
4. Apply the input values and allow for appropriate source settling and compare the measurement results to the appropriate test limits.
5. Repeat step 4 for each gain verification item.
## DC voltage gain verification test

<table>
<thead>
<tr>
<th>Input</th>
<th>Channel 302</th>
<th>Quick check[a]</th>
<th>Error from nominal</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Function[b]</td>
<td>Range</td>
<td>24 hours</td>
</tr>
<tr>
<td>100 mV</td>
<td>100 mV</td>
<td>±8 μV</td>
<td>±10 μV</td>
</tr>
<tr>
<td>−100 mV</td>
<td>100 mV</td>
<td>±8 μV</td>
<td>±10 μV</td>
</tr>
<tr>
<td>1 V</td>
<td>1 V</td>
<td>±21 μV</td>
<td>±31 μV</td>
</tr>
<tr>
<td>−1 V</td>
<td>1 V</td>
<td>±21 μV</td>
<td>±31 μV</td>
</tr>
<tr>
<td>4 V</td>
<td>10 V</td>
<td>±70 μV</td>
<td>±124 μV</td>
</tr>
<tr>
<td>10 V</td>
<td>10 V</td>
<td>±130 μV</td>
<td>±250 μV</td>
</tr>
<tr>
<td>−10 V</td>
<td>10 V</td>
<td>±130 μV</td>
<td>±250 μV</td>
</tr>
<tr>
<td>100 V</td>
<td>100 V</td>
<td>±2.6 mV</td>
<td>±4.1 mV</td>
</tr>
<tr>
<td>−100 V</td>
<td>100 V</td>
<td>±2.6 mV</td>
<td>±4.1 mV</td>
</tr>
<tr>
<td>300 V</td>
<td>300 V</td>
<td>±12 mV</td>
<td>±16.5 mV</td>
</tr>
<tr>
<td>−300 V</td>
<td>300 V</td>
<td>±12 mV</td>
<td>±16.5 mV</td>
</tr>
</tbody>
</table>

\[a\] Q: Quick performance verification test points.

\[b\] For Channel 302, select NPLC 10.
### Ohms gain verification test

<table>
<thead>
<tr>
<th>Input</th>
<th>Channel 302</th>
<th>Quick check[a]</th>
<th>Error from nominal</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Function[b]</td>
<td>Range</td>
<td>24 hours</td>
</tr>
<tr>
<td>100 Ω</td>
<td>4-wire ohms[c] 100 Ω</td>
<td>Q</td>
<td>±8 mΩ</td>
</tr>
<tr>
<td>1 kΩ</td>
<td>1 kΩ</td>
<td>±27 mΩ</td>
<td>±37 mΩ</td>
</tr>
<tr>
<td>10 kΩ</td>
<td>10 kΩ</td>
<td>±250 mΩ</td>
<td>±350 mΩ</td>
</tr>
<tr>
<td>100 kΩ</td>
<td>100 kΩ</td>
<td>±2.5 Ω</td>
<td>±3.5 Ω</td>
</tr>
<tr>
<td>1 MΩ</td>
<td>1 MΩ</td>
<td>±25 Ω</td>
<td>±65 Ω</td>
</tr>
<tr>
<td>10 MΩ</td>
<td>10 MΩ</td>
<td>±1.1 kΩ</td>
<td>±2.1 kΩ</td>
</tr>
<tr>
<td>10 MΩ</td>
<td>2-wire ohms[d][e] 10 MΩ</td>
<td>Q</td>
<td>±1.1 kΩ</td>
</tr>
<tr>
<td>100 MΩ</td>
<td>100 MΩ[f]</td>
<td></td>
<td>±101 kΩ</td>
</tr>
</tbody>
</table>

[a] Q: Quick performance verification test points.
[b] For Channel 321, select NPLC 10.
[c] Fluke 5720A/5730A calibrator: Enable [EX SNS] (external sense) for 4-wire ohms measurement.
[d] For 2-wire ohms, use Math NULL, otherwise an additional 2 Ω error must be added.
[e] Fluke 5720A/5730A calibrator: Enable 2-wire ohms compensation (for 2-Wire ohms measurement ≤ 110 kΩ).
[f] The 100 MΩ range is for 2-wire ohms only.

### DC current gain verification test

<table>
<thead>
<tr>
<th>Input</th>
<th>Channel 321</th>
<th>Quick check[a]</th>
<th>Error from nominal</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Function[b]</td>
<td>Range</td>
<td>24 hours</td>
</tr>
<tr>
<td>1 A</td>
<td>DC current 1 A</td>
<td>Q</td>
<td>±560 μA</td>
</tr>
<tr>
<td>100 mA</td>
<td>100 mA</td>
<td>±14 μA</td>
<td>±35 μA</td>
</tr>
<tr>
<td>10 mA</td>
<td>10 mA</td>
<td>±2.7 μA</td>
<td>±5 μA</td>
</tr>
<tr>
<td>1 mA</td>
<td>1 mA</td>
<td>±100 nA</td>
<td>±350 nA</td>
</tr>
</tbody>
</table>

[a] Q: Quick performance verification test points.
[b] For Channel 321, select NPLC 10.
Frequency accuracy verification

1 Ensure that you have read the “Test Considerations” on page 47.

2 This procedure will measure the input signal from the function/arbitrary waveform generator connected to Channel 302 (frequency). See the connections in “Input test signal” on page 38.

3 Configure each function and range to the respective channel in the order shown in the following table. Provide the indicated input voltage and frequency. Enable **Channel Monitor** on the selected channel before each test (see “Channel monitor” on page 50).

4 Apply the input values and allow for appropriate source settling and compare the measurement results to the appropriate test limits.

5 Repeat step 4 for each accuracy verification item.

<table>
<thead>
<tr>
<th>Input</th>
<th>Channel 302</th>
<th>Quick check[a]</th>
<th>Error from nominal</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Voltage range</td>
<td>24 hours</td>
</tr>
<tr>
<td>0.1 Vrms</td>
<td>10 Hz</td>
<td>1 Vrms</td>
<td>±3 mHz</td>
</tr>
<tr>
<td>0.01 Vrms</td>
<td>300 kHz</td>
<td>0.1 Vrms</td>
<td>Q</td>
</tr>
</tbody>
</table>

[a] Q: Quick performance verification test points.

[b] Keysight 33500B Series function/arbitrary waveform generator: Select **Function** to Sinusoid, **Output Load** to High Impedance (INF).

[c] For Channel 302, select frequency function, voltage range, and 1 second gate time.

AC voltage and AC current gain verification

1 Ensure that you have read the “Test Considerations” on page 47.

2 This procedure will measure the input signal from the calibrator source connected to Channel 302 (AC voltage) and Channel 321 (AC current). See the connections in “Input test signal” on page 38.

3 Configure each function and range to the respective channel in the order shown in the following table. Enable **Channel Monitor** on the selected channel before each test (see “Channel monitor” on page 50).

4 Apply the input values and allow for appropriate source settling and compare the measurement results to the appropriate test limits.
5 Repeat step 4 for each accuracy verification item.

AC voltage gain verification test

<table>
<thead>
<tr>
<th>Voltage</th>
<th>Frequency</th>
<th>Range</th>
<th>AC filter[a]</th>
<th>Quick check[a]</th>
<th>Error from nominal</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>24 hours</td>
<td>90 days</td>
</tr>
<tr>
<td>100 mV</td>
<td>1 kHz</td>
<td>100 mV &gt;200 Hz</td>
<td>±40 μV</td>
<td>±60 μV</td>
<td>±70 μV</td>
</tr>
<tr>
<td></td>
<td>50 kHz</td>
<td>100 mV &gt;200 Hz</td>
<td>±80 μV</td>
<td>±90 μV</td>
<td>±100 μV</td>
</tr>
<tr>
<td></td>
<td>300 kHz</td>
<td>100 mV &gt;200 Hz</td>
<td>±1.1 mV</td>
<td>±1.1 mV</td>
<td>±1.1 mV</td>
</tr>
<tr>
<td>1 V</td>
<td>1 kHz</td>
<td>1 V &gt;200 Hz</td>
<td>±400 μV</td>
<td>±600 μV</td>
<td>±700 μV</td>
</tr>
<tr>
<td></td>
<td>50 kHz</td>
<td>1 V &gt;200 Hz</td>
<td>±800 μV</td>
<td>±900 μV</td>
<td>±1 mV</td>
</tr>
<tr>
<td></td>
<td>300 kHz</td>
<td>1 V &gt;200 Hz</td>
<td>±11 mV</td>
<td>±11 mV</td>
<td>±11 mV</td>
</tr>
<tr>
<td>30 mV</td>
<td>1 kHz</td>
<td>1 kHz &gt;200 Hz</td>
<td>±2 mV</td>
<td>±2 mV</td>
<td>±2.015 mV</td>
</tr>
<tr>
<td>1 V</td>
<td>1 kHz</td>
<td>10 Hz &gt;3 Hz</td>
<td>±2.2 mV</td>
<td>±2.4 mV</td>
<td>±2.5 mV</td>
</tr>
<tr>
<td></td>
<td>10 Hz</td>
<td>10 Hz &gt;3 Hz</td>
<td>±4 mV</td>
<td>±6 mV</td>
<td>±7 mV</td>
</tr>
<tr>
<td></td>
<td>100 Hz</td>
<td>100 Hz &gt;20 Hz</td>
<td>±4 mV</td>
<td>±6 mV</td>
<td>±7 mV</td>
</tr>
<tr>
<td></td>
<td>20 kHz</td>
<td>20 kHz &gt;200 Hz</td>
<td>±4 mV</td>
<td>±6 mV</td>
<td>±7 mV</td>
</tr>
<tr>
<td></td>
<td>50 kHz</td>
<td>50 kHz &gt;200 Hz</td>
<td>±8 mV</td>
<td>±9 mV</td>
<td>±10 mV</td>
</tr>
<tr>
<td></td>
<td>100 kHz</td>
<td>100 kHz &gt;200 Hz</td>
<td>±20 mV</td>
<td>±20 mV</td>
<td>±20 mV</td>
</tr>
<tr>
<td></td>
<td>300 kHz</td>
<td>300 kHz &gt;200 Hz</td>
<td>±110 mV</td>
<td>±110 mV</td>
<td>±110 mV</td>
</tr>
<tr>
<td>100 V</td>
<td>1 kHz</td>
<td>100 V &gt;200 Hz</td>
<td>±40 mV</td>
<td>±60 mV</td>
<td>±70 mV</td>
</tr>
<tr>
<td></td>
<td>50 kHz</td>
<td>100 V &gt;200 Hz</td>
<td>±80 mV</td>
<td>±90 mV</td>
<td>±100 mV</td>
</tr>
<tr>
<td>70 V</td>
<td>300 kHz</td>
<td>70 V &gt;200 Hz</td>
<td>±800 mV</td>
<td>±800 mV</td>
<td>±800 mV</td>
</tr>
<tr>
<td>300 V</td>
<td>1 kHz</td>
<td>300 V &gt;200 Hz</td>
<td>±210 mV</td>
<td>±300 mV</td>
<td>±330 mV</td>
</tr>
<tr>
<td>210 V</td>
<td>50 kHz</td>
<td>210 V &gt;200 Hz</td>
<td>±375 mV</td>
<td>±396 mV</td>
<td>±417 mV</td>
</tr>
<tr>
<td>70 V</td>
<td>300 kHz</td>
<td>70 V &gt;200 Hz</td>
<td>±1.6 V</td>
<td>±1.6 V</td>
<td>±1.6 V</td>
</tr>
</tbody>
</table>

[a] Q: Quick performance verification test points.
[b] For Channel 302, select bandwidth AC filter.
### AC current gain verification test

<table>
<thead>
<tr>
<th>Input</th>
<th>Channel 321</th>
<th>Quick check[a]</th>
<th>Error from nominal</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>24 hours</td>
<td>90 days</td>
</tr>
<tr>
<td><strong>Current</strong></td>
<td><strong>Frequency</strong></td>
<td><strong>Range</strong></td>
<td><strong>AC filter[b]</strong></td>
</tr>
<tr>
<td>1 A</td>
<td>1 kHz</td>
<td>1 A</td>
<td>&gt;200 Hz</td>
</tr>
<tr>
<td></td>
<td>5 kHz</td>
<td></td>
<td></td>
</tr>
<tr>
<td>100 mA</td>
<td>10 Hz</td>
<td>100 mA</td>
<td>&gt;3 Hz</td>
</tr>
<tr>
<td></td>
<td>1 kHz</td>
<td></td>
<td>&gt;200 Hz</td>
</tr>
<tr>
<td>100 μA</td>
<td>1 kHz</td>
<td></td>
<td>&gt;200 Hz</td>
</tr>
<tr>
<td>1 mA</td>
<td>1 kHz</td>
<td>10 mA</td>
<td>&gt;200 Hz</td>
</tr>
<tr>
<td>10 mA</td>
<td>1 kHz</td>
<td></td>
<td>&gt;200 Hz</td>
</tr>
<tr>
<td></td>
<td>5 kHz</td>
<td></td>
<td>Q</td>
</tr>
<tr>
<td>1 mA</td>
<td>1 kHz</td>
<td>1 mA</td>
<td>&gt;200 Hz</td>
</tr>
<tr>
<td></td>
<td>5 kHz</td>
<td></td>
<td>Q</td>
</tr>
<tr>
<td>100 μA</td>
<td>1 kHz</td>
<td>100 μA</td>
<td>&gt;200 Hz</td>
</tr>
<tr>
<td></td>
<td>5 kHz</td>
<td></td>
<td>Q</td>
</tr>
</tbody>
</table>

[a] Q: Quick performance verification test points.

[b] For Channel 321, select bandwidth AC filter.
Plug-in Module Test Considerations

For optimum performance, all test procedures should comply with the following recommendations:

- Assure that the calibration ambient temperature is stable and between 18 °C and 28 °C. Ideally the calibration should be performed at 23 °C ± 1 °C.
- Assure ambient relative humidity is less than 80%.
- Install the plug-in module and allow a 45 minute warm-up period before verification or adjustment.
- Use shielded twisted pair PTFE insulated cables to reduce settling and noise errors. Keep the input cables as short as possible.
- Remove all user wiring and connections from the plug-in modules before verification or adjustment.
- Use 4-wire Ohms measurement techniques for checking relay contact resistance. Check directly at the terminals where possible.

**WARNING**

**TO PREVENT ELECTRICAL SHOCK**

To prevent electrical shock, use only wire that is rated for the highest voltage to any channel. Before removing a module cover, turn off all power to external devices connected to the module.

**WARNING**

**CAUTION WITH MULTIPLE SIGNALS**

To avoid the possibility of multiple signal sources becoming connected together, we recommend when multiplexing two or more sources they should be connected on separate modules or on separate banks of the same module.
**WARNING**

**CAUTION WITH HAZARDOUS VOLTAGES**

When any channel is connected to a hazardous voltage source, all channels in the module should be treated as hazardous and all channel wiring in the module should be rated for the maximum voltage applied.

Thermocouples attached to any other channel on the module should have insulation rated for the maximum voltage, or have additional insulation added rated for the maximum voltage and should be isolated from conductive parts using a thermal compound or tape rated for the maximum voltage applied. Do not mount, move or remove any thermocouples when the device under test is connected to a supply source.

---

**WARNING**

**ENVIRONMENTAL HEALTH & SAFETY**

When any channel is connected to a hazardous voltage source, the instrument and the device under test should be supervised, following local EHS practices to restrict access.
Relay Verification

The following topics are covered in this section:

- “DAQM900A solid state relay on-resistance verification (optional)” on page 78
- “DAQM901A relay contact resistance verification (optional)” on page 79
- “DAQM901A shorted relay contact verification” on page 81
- “DAQM902A relay contact resistance verification (optional)” on page 82
- “DAQM902A shorted relay contact verification” on page 83
- “DAQM903A relay contact resistance verification (optional)” on page 83
- “DAQM903A shorted relay contact verification” on page 84
- “DAQM904A relay contact resistance verification (optional)” on page 85
- “DAQM904A shorted relay contact verification” on page 88
- “DAQM905A relay verification (optional)” on page 89
- “DAQM908A relay contact resistance verification (optional)” on page 90
- “DAQM908A shorted relay contact verification” on page 90

**DAQM900A solid state relay on-resistance verification (optional)**

This procedure checks the relay contact resistance for relays used in Channel 01 to 20 on the DAQM900A. It uses the internal DMM of the DAQ970A/DAQ973A to make resistance measurements. To ensure accurate measurements, the DAQ970A/DAQ973A has to be calibrated prior to this procedure.

**NOTE**
Ensure that you have read the “Plug-in Module Test Considerations” on page 76.

1. Connect copper shorts from H to L for each channel, from Channel 01 to Channel 20.

2. Perform 2-wire resistance measurements for each channel using the DAQ970A/DAQ973A’s internal DMM. Ensure that all measurements are less than 100 Ω.
3 Remove the module from the DAQ970A/DAQ973A mainframe. Retain the copper shorts connected in step 1, and add another wire between Channel 01 L and Channel 11 L.

4 Plug the module back into the DAQ970A/DAQ973A mainframe. Perform a 4-wire resistance measurement for Channel 01 using the DAQ970A’s/DAQ973A’s internal DMM. Ensure that all measurements are less than 2 Ω.

**DAQM901A relay contact resistance verification (optional)**

This procedure checks the relay contact resistance for the relays used in Channel 01 to 20 on the DAQM901A. It uses the internal DMM of the DAQ970A/DAQ973A to make resistance measurements. To ensure accurate measurements, the DAQ970A/DAQ973A has to be calibrated prior to this procedure.

**NOTE** Ensure that you have read the “Plug-in Module Test Considerations” on page 76.

1 Connect the copper shorts from H to L for each channel, from Channel 01 to Channel 20.

2 Perform a 2-wire resistance measurement for each channel using the DAQ970A/DAQ973A’s internal DMM. Ensure that all measurements are less than 2 Ω.

3 Remove the module from the DAQ970A/DAQ973A mainframe. Retain the copper shorts in connected in step 1, and add another wire between Channel 01 L and Channel 11 L.

4 Plug the module back into the DAQ970A/DAQ973A mainframe. Perform a 4-wire resistance measurement for Channel 01 using DAQ970A/DAQ973A’s internal DMM. Ensure that all measurements are less than 2 Ω.
3 Performance Verification

This procedure uses an external DMM to make resistance measurements to check the relay contact resistance for the relays used in Channel 21 and 22 and the F501 and F502 fuses on the DAQM901A. This procedure does not require copper shorts from H to L for Channel 21 and 22 at the beginning of the test.

1. Open all channels on the module by performing a Card Reset (press [Module] select Card Reset; then press Yes to confirm). Remove the module from the DAQ970A/DAQ973A mainframe.

2. Shunt relays K523 and K524 (indicated as Channel 93 and 94 respectively in the front panel module simplified schematic) are closed after the reset. Make a 4-wire measurement across H and L for Channel 21 and 22 with an external DMM. Ensure that the resistances are less than 2 Ω. This will be the K523 and K524 resistance.

3. K522 (indicated by Channel 95 in the front panel module simplified schematic) connects AMPS COM to Channel 21 after the reset. Make a 4-wire resistance measurement across AMPS COM H and AMPS COM L with an external DMM. This will be the sum of the K522 and K523 resistances. Ensure that the resistance is less than 2 Ω.

4. Short H to L for Channel 22. Plug the module back into the DAQ970A/DAQ973A mainframe.

5. Set Channel 22 to measure DCI or ACI. Press [Monitor].

6. Remove the module from the DAQ970A/DAQ973A mainframe without powering down the mainframe. K522 should retain its connection of AMPS COM to Channel 22.

7. Make a 4-wire resistance measurement across AMPS COM H and AMPS COM L with an external DMM. This is the K522 resistance. Ensure that the resistance is less than 2 Ω.
DAQM901A shorted relay contact verification

This procedure uses an external DMM to make 2-wire ohms measurements across all H terminals, followed by all L terminals, on the DAQM901A. As this is to verify open or shorts only, measurement accuracy is not required, so a 2-wire ohms measurement with handheld test probes is sufficient.

1. Open all channels on the module by performing a Card Reset (Press [Module] select Card Reset; then press Yes to confirm). Then, disconnect COM1 from COM2 by opening the Bank relay (Press [Channel] > Advanced > Isolate Banks). Next, press the [ON/Standby] switch to power down the DAQ970A/DAQ973A mainframe. Remove the module from the DAQ970A/DAQ973A mainframe.

2. Measure the resistance from COM1 H terminal to Channel 01 to 10 H terminals. Ensure that they are “open” or more than 10 MΩ. Repeat for L terminals.

3. Measure the resistance from COM2 H terminal to Channel 11 to 20 H terminals. Ensure that they are “open” or more than 10 MΩ. Repeat for L terminals.

4. Measure the resistance from COM1 H terminal to COM2 H terminal. Ensure that they are “open” or more than 10 MΩ. Repeat for L terminals.

5. K522 connects AMPS COM to Channel 21 after the reset. Measure the resistance from AMPS COM H to CH22 H. Ensure that they are “open” or more than 10 MΩ. Repeat for L terminals.

6. Plug the module back into the DAQ970A/DAQ973A mainframe. Set Channel 22 to measure DCI or ACI. Press [Monitor].

7. Remove the module from the DAQ970A/DAQ973A mainframe without powering down the mainframe. K522 should retain its connection of AMPS COM to Channel 22.

8. Measure the resistance from AMPS COM H to CH21 H. Ensure that they are “open” or more than 10 MΩ. Repeat for L terminals.
DAQM902A relay contact resistance verification (optional)

This procedure checks the relay contact resistance for relays used in Channel 01 to 16 on the DAQM902A. It uses the internal DMM of the DAQ970A/DAQ973A to make resistance measurements. To ensure accurate measurements, the DAQ970A/DAQ973A has to be calibrated prior to this procedure.

Ensure that you have read the “Plug-in Module Test Considerations” on page 76.

1. Connect copper shorts from H to L for each channel, from Channel 01 to Channel 16.
2. Perform a 2-wire resistance measurement for each channel using the DAQ970A’s/DAQ973A’s internal DMM. Ensure that all measurements are less than 2 Ω.
3. Remove the module from the DAQ970A/DAQ973A mainframe. Retain the copper shorts in connected in step 1, and add another wire between Channel 01 L and Channel 09 L.
4. Plug the module back into the DAQ970A/DAQ973A mainframe. Perform a 4-wire resistance measurement for Channel 01 using the DAQ970A’s/DAQ973A’s internal DMM. Ensure that all measurements are less than 2 Ω.
DAQM902A shorted relay contact verification

This procedure uses an external DMM to make 2-wire ohms measurements across all H terminals, followed by all L terminals, on the DAQM902A. As this is to verify open or shorts only, measurement accuracy is not required, so a 2-wire ohms measurement with handheld test probes is sufficient.

1. Remove the module from the DAQ970A/DAQ973A mainframe. You do not need to perform a Card Reset to open all channels as the relays will automatically open once the module is removed from the mainframe.

2. Measure the resistance from COM1 H terminal to Channel 01 to 10 H terminals. Ensure that they are “open” or more than 10 MΩ. Repeat for L terminals.

3. Measure the resistance from COM2 H terminal to Channel 11 to 20 H terminals. Ensure that they are “open” or more than 10 MΩ. Repeat for L terminals.

4. Measure the resistance from COM1 H terminal to COM2 H terminal. Ensure that they are “open” or more than 10 MΩ. Repeat for L terminals.

DAQM903A relay contact resistance verification (optional)

This optional procedure uses an external DMM to make 4-wire ohms measurements across the relay contacts on the DAQM903A.

1. Be sure to read “Plug-in Module Test Considerations” on page 76.

2. Install the DAQM903A module in slot 100. Close Channels 01 through 20. Remove the module from the DAQ970A/DAQ973A.

3. Measure the resistance from the CM terminal to the NO terminal on each channel. Ensure that all measurements are less than 1 Ω.

4. Install the module in slot 100. Open Channel 01 through 20. Remove the module from the DAQ970A/DAQ973A.

5. Measure the resistance from the CM terminal to the NC terminal on each channel. Ensure that all measurements are less than 1 Ω.
DAQM903A shorted relay contact verification

This procedure uses an external DMM to make 2-wire ohms measurements across all open terminals on the DAQM903A. As this is to verify open or shorts only, measurement accuracy is not required, so a 2-wire ohms measurement with handheld test probes is sufficient.

1. Install the DAQM903A module in slot 100. Close Channels 01 through 20. Remove the module from the DAQ970A/DAQ973A.

2. Measure the resistance from the CM terminal to the NC terminal on each channel. Ensure that they are “open” or more than 10 MΩ.

3. Install the module in slot 100. Open Channel 01 through 20. Remove the module from the DAQ970A/DAQ973A.

4. Measure the resistance from the CM terminal to the NO terminal on each channel. Ensure that they are “open” or more than 10 MΩ.
DAQM904A relay contact resistance verification (optional)

This optional procedure uses an external DMM to make 4-wire ohms measurements across the relay contacts on the DAQM904A.

Ensure that you have read the “Plug-in Module Test Considerations” on page 76.

1. Connect copper shorts from H to L on each of the eight columns (COL1 through COL8) as shown below. Connect the HI, LO, Sense HI, and Sense LO leads to ROW1 as shown below.

NOTE
For all steps in the following procedures, after connecting or moving test leads, route your wiring for proper strain relief and install the module cover. Install the DAQM904A in slot 200 of the DAQ970A/DAQ973A.

2. Open all channels on the module by performing a Card Reset (press [Module] select Card Reset; then press Yes to confirm).
3 For each test, close only the channels shown in the “Channels Closed” column below (module in slot 200). Record the 4-wire ohms measurements from the external DMM in the following table.

<table>
<thead>
<tr>
<th>Test #</th>
<th>Channel closed[a]</th>
<th>Measured value</th>
<th>Test limit</th>
<th>Relay measured</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Channel 11</td>
<td>___________ Ω</td>
<td>2.00 Ω</td>
<td>K101</td>
</tr>
<tr>
<td>2</td>
<td>Channel 12</td>
<td>___________ Ω</td>
<td>2.00 Ω</td>
<td>K102</td>
</tr>
<tr>
<td>3</td>
<td>Channel 13</td>
<td>___________ Ω</td>
<td>2.00 Ω</td>
<td>K103</td>
</tr>
<tr>
<td>4</td>
<td>Channel 14</td>
<td>___________ Ω</td>
<td>2.00 Ω</td>
<td>K104</td>
</tr>
<tr>
<td>5</td>
<td>Channel 15</td>
<td>___________ Ω</td>
<td>2.00 Ω</td>
<td>K105</td>
</tr>
<tr>
<td>6</td>
<td>Channel 16</td>
<td>___________ Ω</td>
<td>2.00 Ω</td>
<td>K106</td>
</tr>
<tr>
<td>7</td>
<td>Channel 17</td>
<td>___________ Ω</td>
<td>2.00 Ω</td>
<td>K107</td>
</tr>
<tr>
<td>8</td>
<td>Channel 18</td>
<td>___________ Ω</td>
<td>2.00 Ω</td>
<td>K108</td>
</tr>
</tbody>
</table>

[a] Only the channel currently under test should be closed at one time. All other channels should be open.

4 Move the HI, LO, Sense HI, and Sense LO leads to ROW2.

5 Open all channels on the module by performing a Card Reset (press [Module] select Card Reset; then press Yes to confirm).

6 For each test, close only the channels shown in the “Channels Closed” column below. Record the 4-wire ohms measurements from the external DMM in the following table.

<table>
<thead>
<tr>
<th>Test #</th>
<th>Channel closed[a]</th>
<th>Measured value</th>
<th>Test limit</th>
<th>Relay measured</th>
</tr>
</thead>
<tbody>
<tr>
<td>9</td>
<td>Channel 21</td>
<td>___________ Ω</td>
<td>2.00 Ω</td>
<td>K201</td>
</tr>
<tr>
<td>10</td>
<td>Channel 22</td>
<td>___________ Ω</td>
<td>2.00 Ω</td>
<td>K202</td>
</tr>
<tr>
<td>11</td>
<td>Channel 23</td>
<td>___________ Ω</td>
<td>2.00 Ω</td>
<td>K203</td>
</tr>
<tr>
<td>12</td>
<td>Channel 24</td>
<td>___________ Ω</td>
<td>2.00 Ω</td>
<td>K204</td>
</tr>
<tr>
<td>13</td>
<td>Channel 25</td>
<td>___________ Ω</td>
<td>2.00 Ω</td>
<td>K205</td>
</tr>
<tr>
<td>14</td>
<td>Channel 26</td>
<td>___________ Ω</td>
<td>2.00 Ω</td>
<td>K206</td>
</tr>
</tbody>
</table>
7 Move the HI, LO, Sense HI, and Sense LO leads to ROW3.

8 Open all channels on the module by performing a Card Reset (press [Module] select Card Reset; then press Yes to confirm).

9 For each test, close only the channels shown in the “Channels Closed” column below. Record the 4-wire ohms measurements from the external DMM in the following table.

<table>
<thead>
<tr>
<th>Test #</th>
<th>Channel closed[a]</th>
<th>Measured value</th>
<th>Test limit</th>
<th>Relay measured</th>
</tr>
</thead>
<tbody>
<tr>
<td>15</td>
<td>Channel 27</td>
<td>__________ Ω</td>
<td>2.00 Ω</td>
<td>K207</td>
</tr>
<tr>
<td>16</td>
<td>Channel 28</td>
<td>__________ Ω</td>
<td>2.00 Ω</td>
<td>K208</td>
</tr>
</tbody>
</table>

[a] Only the channel currently under test should be closed at one time. All other channels should be open.

10 Move the HI, LO, Sense HI, and Sense LO leads to ROW4.

11 Open all channels on the module by performing a Card Reset (press [Module] select Card Reset; then press Yes to confirm).
For each test, close only the channels shown in the “Channels Closed” column below. Record the 4-wire ohms measurements from the external DMM in the following table.

<table>
<thead>
<tr>
<th>Test #</th>
<th>Channel closed[a]</th>
<th>Measured value</th>
<th>Test limit</th>
<th>Relay measured</th>
</tr>
</thead>
<tbody>
<tr>
<td>25</td>
<td>Channel 41</td>
<td>_______ Ω</td>
<td>2.00 Ω</td>
<td>K401</td>
</tr>
<tr>
<td>26</td>
<td>Channel 42</td>
<td>_______ Ω</td>
<td>2.00 Ω</td>
<td>K402</td>
</tr>
<tr>
<td>27</td>
<td>Channel 43</td>
<td>_______ Ω</td>
<td>2.00 Ω</td>
<td>K403</td>
</tr>
<tr>
<td>28</td>
<td>Channel 44</td>
<td>_______ Ω</td>
<td>2.00 Ω</td>
<td>K404</td>
</tr>
<tr>
<td>29</td>
<td>Channel 45</td>
<td>_______ Ω</td>
<td>2.00 Ω</td>
<td>K405</td>
</tr>
<tr>
<td>30</td>
<td>Channel 46</td>
<td>_______ Ω</td>
<td>2.00 Ω</td>
<td>K406</td>
</tr>
<tr>
<td>31</td>
<td>Channel 47</td>
<td>_______ Ω</td>
<td>2.00 Ω</td>
<td>K407</td>
</tr>
<tr>
<td>32</td>
<td>Channel 48</td>
<td>_______ Ω</td>
<td>2.00 Ω</td>
<td>K408</td>
</tr>
</tbody>
</table>

[a] Only the channel currently under test should be closed at one time. All other channels should be open.

**DAQM904A shorted relay contact verification**

This procedure uses an external DMM to make 2-wire ohms measurements across all H terminals, followed by all L terminals, on the DAQM904A. As this is to verify open or shorts only, measurement accuracy is not required, so a 2-wire ohms measurement with handheld test probes is sufficient.

1. Remove all copper shorts between H and L on all columns.
2. Open all channels on the module by performing a Card Reset (press [Module] select Card Reset, then press Yes to confirm). Remove the module from the DAQ970A/DAQ973A mainframe.
3. Measure the resistance from row 1 H terminal to all eight column’s H terminals. Ensure that they are “open” or more than 10 MΩ. Repeat this step for all the other three rows.
4. Repeat step 3 for L terminals.
DAQM905A relay verification (optional)

This optional procedure uses an external DMM to check that the RF relay is functioning, using 2-wire ohms measurement with handheld test probes.

1. Be sure to read “Plug-in Module Test Considerations” on page 76.

2. Prepare the module by connecting an SMB short to CH10, CH11, CH12, and CH13. Connect the COM1 terminal to the DMM.

   *Be sure to use the correct SMB connectors for the module.*

3. Install the module in slot 100.


5. Measure the resistance on the DMM. Ensure that measurements is less than 1 Ω. Replace the module if the relay contact resistance is in excess of 1 Ω.

6. Close all other channels.

7. Measure the resistance, ensure that they are “open” or more than 10 MΩ. Replace the module if the relay contact resistance if less than 10 MΩ.

8. Repeat steps 4 and 7 for Channels 12, 13, and 14.

9. Repeat steps 2, 3, 4, 5, 6, 7, and 8 for the channels connected to COM2.
DAQM908A relay contact resistance verification (optional)

This procedure checks the relay contact resistance for relays used in Channel 01 to 40 on the DAQM908A. It uses the internal DMM of the DAQ970A/DAQ973A to make resistance measurements. To ensure accurate measurements, the DAQ970A/DAQ973A has to be calibrated prior to this procedure.

Ensure that you have read the “Plug-in Module Test Considerations” on page 76.

1. Connect copper shorts from each channel to the L terminal.
2. Perform a 2-wire resistance measurement for each channel using the DAQ970A's/DAQ973A's internal DMM. Ensure that all measurements are less than 2 Ω.

DAQM908A shorted relay contact verification

This procedure uses an external DMM to make 2-wire ohms measurements across all H terminals on the DAQM908A. As this is to verify open or shorts only, measurement accuracy is not required, so a 2-wire ohms measurement with handheld test probes is sufficient.

1. Open all channels on the module by performing a card reset. Remove the module from the DAQ970A/DAQ973A mainframe.
2. Measure the resistance from the H terminal (far left in the row of input terminals) to Channel 01 to 20 terminals. Ensure that they are “open” or more than 10 MΩ.
3. Plug the module back into DAQ970A/DAQ973A mainframe. Set channel 21 to “close”. Remove the module from the mainframe. K422 (indicated by Channel 99 in the front panel module simplified schematic) should connect the Common H terminal (second terminal from the left) to bank 2.
4. Measure the resistance from the Common H terminal to CH22 to 40 terminals. Ensure that they are “open” or more than 10 MΩ.
5. Plug the module back into the DAQ970A/DAQ973A mainframe again. Set Channel 22 to “close”. Remove the module from the mainframe.
6 Measure the resistance from the Common H terminal to CH22 terminals. Ensure that they are “open” or more than 10 MΩ.
3 Performance Verification

DAQM907A Analog Output Verification (Optional)

This procedure is used to check the calibration of the analog outputs (Channel 04 and 05) on the DAQM907A. Perform the module auto-calibration before starting this test. When performing module auto-calibration, the analog outputs and sense inputs will be calibrated to the DMM in the DAQ970A/DAQ973A.

1 Make connections to the analog output channels (Channel 04 and 05) as shown below using either an external DMM or a DAQM901A module inserted into an unused slot in the same DAQ970A/DAQ973A mainframe.

2 For each analog output, set each output value in the table below. Compare the measurement results to the appropriate test limits shown in the table below.

<table>
<thead>
<tr>
<th>DAC output</th>
<th>Measured output</th>
<th>Error from nominal 1 year</th>
</tr>
</thead>
<tbody>
<tr>
<td>10 V</td>
<td>10 V</td>
<td>±7.1 mV</td>
</tr>
<tr>
<td>0 V</td>
<td>0 V</td>
<td>±4.4 mV</td>
</tr>
<tr>
<td>−10 V</td>
<td>−10 V</td>
<td>±7.1 mV</td>
</tr>
<tr>
<td>20 mA</td>
<td>20 mA</td>
<td>±0.0274 mA</td>
</tr>
<tr>
<td>0 A</td>
<td>0 A</td>
<td>±0.0044 mA</td>
</tr>
<tr>
<td>−20 mA</td>
<td>−20 mA</td>
<td>±0.0274 mA</td>
</tr>
</tbody>
</table>
DAQM907A Analog Sense Inputs Verification (*Optional*)

This procedure is used to check the calibration of the analog sense inputs (Channel 06 and 07) on the DAQM907A.

1. Remove connections in previous test and make connections to Channel 04 and 05 as shown below:

   ![Connection Diagram]

   A wire is not needed to short Channel 04 GND to Channel 05 GND because they are already shorted on board.

2. Set the following voltage and current outputs for Channel 04 and 05. Compare the measurement results of Channel 06 and 07 to the appropriate test limits shown in the table below.

<table>
<thead>
<tr>
<th>Channel 04 output</th>
<th>Channel 05 output</th>
<th>Channel 06 result limits</th>
<th>Channel 07 result limits</th>
</tr>
</thead>
<tbody>
<tr>
<td>10 V</td>
<td>20 mA</td>
<td>−20 mA ± 0.0274 mA</td>
<td>10 V ± 7.1mV</td>
</tr>
<tr>
<td>−20 mA</td>
<td>−10 V</td>
<td>−10 V ± 7.1mV</td>
<td>20 mA ± 0.0274 mA</td>
</tr>
</tbody>
</table>
Thermocouple Reference Junction Verification *(Optional)*

To make a thermocouple measurement a known reference junction temperature measurement must be made. The reference junction temperature is measured by three solid state temperature sensors in the input connection area on the module. *Thermocouple measurements are only supported by the DAQM900A, DAQM901A, and DAQM902A.*

1. Read the “Plug-in Module Test Considerations” on page 76.
2. Connect a calibrated thermocouple with an accuracy of 0.1 °C or better to one of the following channels:
   - For the DAQM900A: Channel 1 and 20
   - For the DAQM901A: Channel 1 and 20
   - For the DAQM902A: Channel 1 and 16
3. Install the module in slot 100.
4. Place the J Type calibrated thermocouple at a known temperature (ice bath or calibrator).
5. Select Channel 101. Configure the channel as follows:
   - TEMPERATURE
   - THERMOCOUPLe
   - J TYPE
   - INTEG 10 PLC
   - INTERNAL REF *(Advanced menu)*
   
   Before executing each test, you must press *[Monitor]* to enable reading monitoring on the selected channel (or use the ROUTe:MON command from the remote interface).

6. Subtract the thermocouple error from the displayed temperature. Verify the result is within ±1.0 °C of the known temperature (set in step 4).

*NOTE* You should perform these verification and adjustments if you are using the modules for thermocouple measurements.
DAQM909A DC/AC Coupling Verification *(Optional)*

This procedure is used to verify the basic functionalities of the DAQM909A 4-Channel Digitizer module. Self Test and Autocalibration covers most functionalities except for DC/AC coupling mode which exercises on board relays at specified channel under test. The subsequent procedures are designed to verify the functionality of the DC/AC coupling relays at each channel. This test is optional.

1. Connect all input channels (Channel 1 to 4) in parallel to a DC Voltage source according to the diagram below and insert the module in any available slot, e.g. slot 1, and power ON the mainframe. Do not apply any voltage to the channels.

2. Perform Full Self-Test using either methods below:
   - Front panel operation: Press `[Utility] > Self Test > Full Test`
   - Remote interface operation: “TEST:ALL?”

Refer to “Full self-test” on page 24, or “TEST:ALL?” in the DAQ970A/DAQ973A Programming Guide for more details.
3 Performance Verification

Perform Autocalibration using either methods below:
- Front panel operation: Press [Utility] > Autocal > Perform Autocal
- Remote interface operation: “*CAL?” or “SYSTem:ACALibration? {<slot>|DMM|ALL}”

NOTE Refer to “*CAL?” in the DAQ970A/DAQ973A Programming Guide for more details.

4 Apply the following settings at Channel 101:
   i Press the [Channel] key to enter the [Channel] menu
   ii Press Measure > DCV
   iii Press Volt Range > 300mV
   iv Next, press Advanced > Mode > Freq
   v Press Type > Diff > Done
   vi Press [Interval] > Sample Settings > Samp Rate > 6.25K
   vii Use the knob or arrow keys to set Samp Count value to 1250.
   viii Press Done.

5 Copy the settings from Channel 101 to Channels 102 through 104.
   i Press [Copy] key to enter the [Copy] menu.
   ii Press Source Chan(s) > Start Channel and use the knob or arrow keys and set Start Channel to 101.
   iii Press End Channel and use the knob or arrow keys and set End Channel to 101.
   iv Next, press Dest. Chan(s) > Start Channel and use the knob or arrow keys and set Start Channel to 102.
   v Press End Channel and use the knob or arrow keys and set End Channel to 104.
   vi Press Copy Now to initiate the copying process.
   vii Once the process is completed, press the [Home] key.

6 Apply 600 mV from a DC voltage source at Channel 101 to Channel 104.
7 In the [Home] menu, select Channel 101 and press [Scan/Start] key to begin digitizing.

8 Once the digitizer operation is complete, press [View] and ensure Channel 101 is selected using the up/down arrow keys. Next, press Measure Settings > Analysis > Statistics > Done. Verify that the DC voltage average value is ~600 mV ± 60 mV.

9 Next, apply the following settings at Channel 101:
   i Press the [Channel] key > Advanced > Coupling > AC > Done.
   ii Press the [Interval] key > Trigger Settings > Source > Manual > Done.

10 Press the [Scan/Start] key, wait for 5 seconds, and press the [Scan/Start] key again.

11 Once the digitizer operation is complete, press [View]. Verify that the DC voltage average value is ±0.6 mV.

12 Press [Interval] > Trigger Settings > Source > Auto > Done to change the Trigger Source of Channel 101 to Auto.

13 Repeat steps 7 to 12 for Channels 102 through 104.
3 Performance Verification

THIS PAGE HAS BEEN INTENTIONALLY LEFT BLANK.